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Copyright

© Copyright 2008, Welch Allyn. All rights are reserved. No one is permitted to translate,
reproduce or duplicate this manual or any part thereof, in any form, without prior written
permission from Welch Allyn. Welch Allyn assumes no responsibility for any injury to anyone,
or for any illegal or improper use of the product, that may result from failure to use this product
in accordance with the instructions, cautions, warnings, or statement of intended use
published in this manual.

Unauthorized copying of this publication may not only infringe copyright but also reduce the
ability of Welch Allyn to provide accurate and up-to-date information to users and operators
alike.

Welch Allyn®, CardioPerfect® Workstation and SpiroPerfect® are registered trademarks of
Welch Allyn.

Software in this product is Copyright 2008, Welch Allyn. All rights are reserved. The software
is protected by United States of America copyright laws and international treaty provisions
applicable worldwide. Under such laws, the licensee is entitled to use the copy of the
software provided on the original distribution medium. The software may not be copied,
decompiled, reverse-engineered, disassembled or otherwise reduced to human-perceivable
form. This is not a sale of the software or any copy of the software; all right, title and
ownership of the software remains with Welch Allyn.

The information contained in this manual is subject to change without notice.
All changes will be in compliance with regulations governing manufacture of medical
equipment.

User responsibility

This product is designed to perform in conformity with the description thereof contained in this
manual and accompanying labels and inserts, when assembled, operated, maintained and
repaired in accordance with the instructions provided. A defective product should not be
used. Parts that are broken, plainly worn, missing or incomplete, distorted or contaminated
should be replaced immediately. Should any repair or replacement become necessary, we
recommend that service be performed at the nearest approved service center. The user of
the product shall have the sole responsibility for any malfunction, which results from improper
use, faulty maintenance, improper repair, damage or alteration by anyone other than Welch
Allyn or their authorized service personnel.

Accessories
The Welch Allyn warranty can only be honored if you use Welch Allyn approved accessories
and replacement parts.

Caution Use of accessories other than those recommended by Welch Allyn
may compromise product performance.
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Warranty, Service, and Spare Parts

Warranty

All repairs on products under warranty must be performed or approved by Welch Allyn.
Unauthorized repairs will void the warranty. In addition, whether or not covered under
warranty, any product repair shall exclusively be performed by Welch Allyn certified service
personnel.

Assistance and Parts
If the product fails to function properly or if assistance, service, or spare parts are required,
contact the nearest Welch Allyn Technical Support Center.

USA 1-800-535-6663 Canada 1-800-561-8797
Latin America (+1) 305-669-9591 South Africa  (+27) 11-777-7509
European Call Center  (+353) 469-067-790 Australia (+61) 2-9638-3000
United Kingdom (+44) 207-365-6780 Singapore (+65) 6291-0882
France (+33) 1-60-09-33-66 Japan (+81) 3-5212-7391
Germany (+49) 7477-927-173 China (+86) 21-6327-9631

Before contacting Welch Allyn it is helpful to attempt to duplicate the problem and to check all
accessories to ensure that they are not the cause of the problem.

When calling, please be prepared to provide:

e Product name and model number and complete description of the problem

e The serial number of your product (if applicable)

e The complete name, address and phone number of your facility

e For out-of-warranty repairs or spare parts orders, a purchase order (or credit card)
number

e For parts order, the required spare or replacement part number(s)

Repairs

If your product requires warranty, extended warranty, or non-warranty repair service, please
call first the nearest Welch Allyn Technical Support Center. A representative will assist you
troubleshooting the problem and will make every effort to solve it over the phone, avoiding
potential unnecessary return.

In case the return cannot be avoided, the representative will record all necessary information
and will provide a Return Material Authorization (RMA) nhumber, as well as the appropriate
return address. A Return Material Authorization (RMA) number must be obtained prior to any
return.

Note Welch Allyn does not accept returned products without an RMA.

Packing Instructions

If you have to return goods for service, follow these recommended packing instructions:

o Remove all hoses, cables, sensors, power cords, and ancillary products (as appropriate)
before packing, unless you suspect they are associated with the problem.

e Wherever possible use the original shipping carton and packing materials.

¢ Include a packing list and the Welch Allyn Return Material Authorization (RMA) number.

It is recommended that all returned goods be insured. Claims for loss or damage to the
product must be initiated by the sender.
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Limited Warranty Statement

Welch Allyn, Inc. warrants that the SpiroPerfect computer based Spirometer you have
purchased (the Product) meets the labeled specifications of the Product and will be free from
defects in materials and workmanship that occur within 1 year after the date of purchase.
Accessories used with the Product are warranted for 90 days after the date of purchase. Such
accessories include: disposable flow transducers, pressure tubing, and nose clip.

The date of purchase is: 1) the date specified in our records, if you purchased the Product
directly from us, 2) the date specified in the warranty registration card that we ask you to send
to us, or 3) if you don’t return the warranty registration card, 120 days after the date on which
the Product was sold to the dealer from whom you bought the Product, as documented in our
records.

This warranty does not cover damage caused by: 1) handling during shipping, 2) use or
maintenance contrary to labeled instructions, 3) alteration or repair by anyone not authorized
by Welch Allyn, and 4) accidents.

If a Product or accessory covered by this warranty is determined to be defective because of
defective materials, components, or workmanship, and the warranty claim is made within the
warranty period described above, Welch Allyn will, at its discretion, repair or replace the
defective Product or accessory free of charge.

You must obtain a return authorization from Welch Allyn to return your Product before you
send it to Welch Allyn’s designated service center for repair.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. WELCH ALLYN'S OBLIGATION UNDER
THIS WARRANTY IS LIMITED TO REPAIR OR REPLACEMENT OF PRODUCTS
CONTAINING A DEFECT. WELCH ALLYN IS NOT RESPONSIBLE FOR ANY INDIRECT
OR CONSEQUENTIAL DAMAGES RESULTING FROM A PRODUCT DEFECT COVERED
BY THE WARRANTY.

DIR 80012334 Ver. C 4/95



WﬁlCl\A].lYll@ CardioPerfect Workstation

SpiroPerfect Module — User Manual

Table of Contents

1 INEFOTUCTION ettt 8
1.1 ADOUL ThiS MANUAL .......eeeiiiiiii e 8
1.2 SYMDOIS ... 8
1.3 Using the Spirometer Safely ..., 10
14 ProdUCE OVEIVIEW......coiiiiiiiiiieee ettt e e e e e e 12
15 FRALUIES ... e 13

2 General iINformMation ... 14
2.1 LAY (oo o = 2 14
2.2 Intended Use / Indications for USe.........coooeviiiiiii e 14
2.3 ContraindiCatioNS ...........cooviiiiiiii e 14
2.4 Important ConsiderationS...........oooooveiiiii e, 15

3 Installing the SpiroPerfect Spirometer .........cccoovvviiiiiiiiiiiiiiieeeeeeee, 16
3.1 Connecting the Flow Sensor with USB connection to the Computer....... 16
3.2 Configuring the Welch Allyn CardioPerfect Workstation.......................... 19

4 The Spirometer WiNUOW .........covvviiiiiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeee e 20

5 Customizing the Spirometry Module ..........ccoovviiiiiiiiiee, 22
5.1 General Tab ... 22
5.2 ViIeWiNg Tab ..o 24
5.3 Parameters Tab .....coooiiiiiiiiie e 26
54 PrNtING Tab....oeeiiiieee e 28
5.5 ReCOrding Tab ....ccooeiieeeeee e 30
5.6 Customize the spiro.txtfile.......ccccoiii 31

6 Ambient Settings /Temperature, Humidity and Pressure .............. 32
6.1 Why the Workstation needs Ambient Setting Information........................ 32
6.2 When to Adjust the Ambient SEettings .......ccccoeeveiiieiiieiieee e, 32
6.3 Adjusting the AmDbIient SEtliNgS ........ccev i 32

7 Calibration of FIOW SENSOr ..., 34
7.1 Preparing calibration.............ccccooo i, 34
7.2 The Calibration PrOCESS. ... ... e 34
7.3 View Calibration RESUILS ..........u e 39
7.4 Error Messages Associated with Failed Calibration................................ 40
7.5 CaliDration 10g .. ...eeeiieeiiie e 41

DIR 80012334 Ver. C 5/95



WﬁlCl\A].lYll@ CardioPerfect Workstation

SpiroPerfect Module — User Manual

8 Recording Spirometry TeSTS .....coiii i 43
8.1 Record a SPIirOmMetry TeSt....ccii i i i e e 43
8.2 INCENTIVE SCIEEN ..ot e e 46
8.3 Patient ProCeAUIES ......ccooi i 47
8.4 Deleting an Effort ... 48
8.5 Add or Change Information in the Comment Editor..............coeeeeeeeeieeenn. 49

9 VIiewing SPIrometry teSTS. ... 50
9.1 View a SPIrOMELrY 1ESt.....cvviiiii i e eeeaeees 50
9.2 Setting the Best EffOrt...........uuuiiiiiiiiiiiiiiiiiiiiiienennannes 50
9.3 View and Add Information t0 @ TeSt......ccoeeevieeiieei e, 50
9.4 TesSt MOAES AN TaDS ......uui s 51
9.5 Common Features for each Tab..........c..cocoeiiiiii 53

9.5.1 Parameters AlCa.........oouiiiiiiiiiiiiiiiiieeee ettt ae e aaee s st aeeeeebnrnrebernrnne 54

9.5.2 Ta10=Tq ol =) r= Ao ] o 1 AN =T PSSR 54
9.6 FVC TaD ... e 55
9.7 SVC TaAD e e 56
9.8 MVV TaD e 57
9.9 I (= T IR = o 58
9.10 MeaSUIEMENTS Tab ... 59
9.11 COMPAIE TESES ouniieiii e e e e e e e e e aaa e 60

10 Interpreting SPIrometry TeSTS ...ccovviiiiiiiiiiii e 61
10.1  Editing and Confirming an Interpretation ..............cccccoviiiiie 61
10.2  Automatic INterpretation..........occevvieeiiiis e e 62
10.3  View Interpretation HiSTOIY .........couiiiiiiiiiiiiiiieee e 62
10.4  Reanalyze a SpPIrometry TeSt........ooiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeeeee e 63
10.5 Recalculate prediCtion..........ccoooeeviieiiiiiii e e 63

11 Printing SPIrOMetry 1SS .t 65
I3 R o 10 £ o I €= o o] o £ 65
11.2  Print REPOrt FOIMALS......cuuuiiiii it e et e e e e 66
11.3  PriNEPIOVIEW ..ottt 66

12 PrediCtions. ... 67
12,1 NOIM PrOfIlES .ot 67
12.2  Norm-Related Clinical StUdIeS............ccovvviiiiiiiiiii e 69
HIDZ8C T (o] 00 ¢ I =14 1 = T o To ] = i T ) o [ 70
12.4  Composite NOIM ValUBS .....ccooeeiiieiiiiiii et e et e e 70

DIR 80012334 Ver. C 6/95



WelCl\A].lyn® CardioPerfect Workstation

SpiroPerfect Module — User Manual

12.5 U] o o 71
12.6  Ethnic group COMreCtioN ...........cccovviiiiiiiiiiiieeeee e 71
12.7  Understanding Interpretation RESUIS ............ccoovviiiiiiiiiiiiieiiiiiiiieeeeeen 72
D2 S R (Y (T = o =L PR 73
13 Maintaining the Spirometer — Welch Allyn .........ccccoviiiiiiiiiiiiiiiiiinns 74
13.1  Maintaining the SENSOF .........ooviiiiiii e 74
13.2  Cleaning the SPIrOMELEN ......cciieeiieeecce e e 74
13.3  Ordering Information for Replacement Parts...............cccccccvviiinn, 75
14 TroubleShOOtING ... 77
15  SPECIHTICALIONS cuuuiiii i e e 79
16 Statutory and Regulatory RequirementsS.........cccceevvviiiinieeeeeeeeennnnnns 81
17 Guidance and Manufacturer’s DeclarationsS...........ccc..evvvvvveeeeenennee. 82
18  Spiro Perfect VCT-400........uuiiiiiieeeeeeeeiiee e 86
18.1  Connect the flow sensor to the computer .........cccceevveeiiiiiiiiineeeeee, 86
18.1.1 Configure Welch Allyn CardioPerfect Workstation ...........cccccooveevvvieiineeeeninnnnns 86
18.1.2 Preparing the floW SENSOI ...........uiiiiiiie e 86
18.2  Maintaining the floW SENSOT .........cooiiiiiiiiiiiiiiee e 87
18.3  TroubleShooting .......covviiiiiiee e 88
19 FUNCLION KBYS oo 89
20 GlOSSANY it 90

DIR 80012334 Ver. C 7195



WelCl\A].lyn® CardioPerfect Workstation

SpiroPerfect Module — User Manual

1 Introduction

1.1 About This Manual

This manual is written for clinical professionals performing pulmonary function testing.
Users must be familiar with measurements and the clinical significance of basic spirometry
products.

Caregivers need to know how to properly coach patients, recognize acceptable waveforms
and know whether results are reproducible or not and whether they meet ATS criteria or not.

The hospital's Biomedical/IT support staff shall require primary skills including disciplines
related to maintenance and servicing computer controls/platforms. It is recommended that
users attend a certified spirometry training course. The instructions given here are only a
guide and should not be used to train a technician.

For definitions of specialized terms and abbreviations related to spirometry, see the Glossary.

Before using the spirometer, all users and technicians must read and understand this manual
and all other information accompanying the SpiroPerfect spirometry option and the
CardioPerfect workstation.

Note

This manual supplements the CardioPerfect workstation manual, entitled
CardioPerfect Workstation User Manual. For information that the workstation and
spirometry functions share — for example, instructions for moving through the menus,
searching for patient data — see the CardioPerfect workstation manual.

Please take note of all safety precautions and warnings provided with this device
before using this device and the accompanying software.

We at Welch Allyn are dedicated to provide safe products to our customers. It is the user’s
responsibility to follow the rules of safety as established for their protection and for the
protection of their patients as described in this manual. Please take special note of the safety
and precautions as described in Using the Spirometer Safely on page 10.

1.2 Symbols

The symbols shown below may appear on the spirometer components, on the packaging, on
the shipping container, or in this manual.

Documentation Symbols

A WARNING Indicates conditions or practices that, if continued or not

corrected immediately, could lead to iliness, injury, or death.

corrected immediately, could damage the equipment.

Indicates conditions or practices that, if continued or not
& CAUTION P

Shipping, Storing, and Environment Symbols

® Single use

DIR 80012334 Ver. C 8/95
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g 200x-xx

Expiration date

/,
o=

\
-)/_/ :

Keep away from sunlight

Stacking limits

| 54| o

Do not dispose of this product as unsorted municipal waste. Prepare
this product for reuse or separate collection as specified by Directive
2002/96/EC of the European Parliament and the Council of the
European Union on Waste Electronic and Electrical Equipment
(WEEE). If this product is contaminated, this directive does not apply.
Fore more specific disposal information contact Welch Allyn
Customer Service, see page 3 for telephone numbers.

Certification Symbols

Meets essential requirements of European Medical Device Directive
93/42/EEC

The authorized representative in the European Community

DIR 80012334 Ver. C
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1.3

Using the Spirometer Safely

Before using or servicing the spirometer, you must read and understand the following
safety-related information.

/N

WARNING:

Do not perform spirometry test if any of the following conditions apply to

the patient:

¢ hemoptysis of unknown origin (forced expiratory maneuver may aggravate the
underlying condition);

e pneumothorax;

e unstable cardiovascular status (forced expiratory maneuver may worsen
angina or cause changes in blood pressure) or recent myocardial infarction or
pulmonary embolus;

e thoracic, abdominal, or cerebral aneurysms (danger of rupture due to
increased thoracic pressure);

e recent eye surgery (e.g., cataract);

e presence of an acute disease process that might interfere with test
performance (e.g., nausea, vomiting);

e recent surgery of thorax or abdomen.

WARNING The spirometer captures and presents data reflecting a patient’s
physiological condition. When reviewed by a trained physician or clinician, this
data can be useful in determining a diagnosis. However, the data should not be
used as a sole means for determining a patient’s diagnosis.

WARNING To minimize chances of a misdiagnosis, it is the physician’s
responsibility to assure that spirometry tests are properly administered, evaluated,
and interpreted.

WARNING People may become light-headed, dizzy, or even faint during a
spirometry effort. Watch patients closely. If they choose to stand during testing,
keep a chair immediately behind them. If there is any reason for concern, stop the
test and take appropriate action.

WARNING To prevent cross-contamination, do not try to clean the flow
transducers and nose clips. Discard these items after a single patient use.

WARNING The American Thoracic Society (ATS) recommends using rubber
gloves when replacing disposable flow transducers, and washing hands after
touching them.

DIR 80012334 Ver. C 10/95
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N

WARNING:

The CardioPerfect family of devices is an integral part of a personal
computer based diagnostic system. The user shall adhere to warnings in
order to ensure safe and reliable performance of the system.

The personal computer (non-medical electrical equipment) shall be situated
outside the patient environment (reference IEC 60601-1-1).

The personal computer used should adhere to the appropriate safety standard for
non-medical electrical equipment (IEC 60950, or its national variants), and use of
an isolation transformer is recommended.

The personal computer used should adhere to the appropriate electromagnetic
compatibility (EMC) standard for non-medical electrical equipment (CISPR 22/24 -
FCC Part 15 - CE, or related national variants).

If it is required for the personal computer to be situated within the patient
environment, it is the responsibility of the user to ensure that the system provides
a level of safety in compliance with IEC 60601-1.

WARNING A color printer and a color printout are recommended for printing
Spirometry reports. Printing these reports with a monochrome printer or in black
and white can lead to confusion as it is not easy to identify which curve is a Pre
and which is a Post effort.

CAUTION

Do not clean the pressure tubing or sensor. Trapped moisture could affect their
accuracy. Replace the pressure tubing when it becomes dirty. Replace the sensor
when it becomes faulty.

CAUTION Do not use aromatic hydrocarbons, rubbing alcohol, or solvents for
cleaning the spirometer.

CAUTION Do not immerse any part of the spirometer into a cleaning liquid or
sterilize it with hot water, steam, or air.

CAUTION You cannot clean the spirometer or any of its components. If you
choose to clean the calibrations syringe, wipe its external surfaces as needed with
a cloth dampened with water only.

CAUTION Use only parts and accessories supplied with the device and available
through Welch Allyn. The use of accessories other than those specified my result
in degraded performance of the device.

CAUTION When you put the spirometer away, store its pressure tubing in a
basket or drawer or other place that prevents compression or kinking.

CAUTION Avoid installing the spirometer in direct sunlight or in a location where it
may be affected by significant changes in humidity, ventilation, or airborne
particles containing dust, salt or sulfur.

CAUTION Keep the spirometer away form splashing fluids.

CAUTION Do not over tighten the rotor when assembling the Viasys VCT400
Spirometer. This can lead to inaccurate registration of low volume rates.
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1.4 Product Overview

SpiroPerfect performs FVC, SVC and MVV testing, including pre-post testing.
It instantly displays flow-volume curves and depicts inspiratory and expiratory
measurements.

For details, see the following sections:

e Features (page 13)

e Ordering Information for Replacement Parts (page 75)
e Specifications (page 79)

Figure 1.1 Components of the SpiroPerfect Spirometer

AN Disposable Flow Transducer
% For single patient use only to minimize the risk of cross
contamination.

Pressure Tubing
i Connects the flow transducers to the Spirometer
sensor.

Serial Sensor
Connects to the serial port of your PC.
Converts pressure to airflow.

USB Sensor
Connects to the USB port of your PC.
Converts pressure to airflow.

Assembled SpiroPerfect Spirometer
Consists of: Disposable Flow transducer, Pressure
tubing and Sensor, either Serial or USB.

Note: Only one sensor is shipped with the Spirometer.
It is either the Serial or USB sensor.

Nose Clip

Highly recommended during testing to avoid air leaks.
Unless a medical condition makes it uncomfortable or
unpractical to use it, in which case, the clinician should
record that the nose clip was not used.

3 liter Calibration syringe
For daily use, to calibrate the Welch Allyn SpiroPerfect
spirometer for accuracy.

DIR 80012334 Ver. C 12/95
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1.5 Features

Automatic interpretation and comparison to best pre-bronchodilator.

Real-time flow/volume and volume/time graphs.

Incentive graphic for pediatric patient coaching.

Multiple predicted norms.

Customizable report formats.

Validated to meet the American Thoracic Society spirometry accuracy standards for both
ambient and BTPS humidified air.

Instant quality and variability check for proper test performance.

Single-stroke and multiple-stroke calibration protocols.

Reduced risk of cross contamination with Welch Allyn single-use, disposable flow
transducers.

Meets all industry standards, including ATS, NIOSH, OSHA and Social Security.
Trending of several different tests from the same patient.

DIR 80012334 Ver. C 13/95
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2 General information

2.1 Welcome

Welcome to the SpiroPerfect module of the Welch Allyn CardioPerfect Workstation. With this
module, you can record, view and interpret spirometric tests. You can also use it to print
spirometry tests in various formats.

The SpiroPerfect module exceeds the recommendations for spirometry of the American
Thoracic Society (ATS).

This manual contains specific information about the SpiroPerfect module of the Welch Allyn
CardioPerfect Workstation. For all general information about the workstation software, please
refer to the Workstation manual, which describes:

e Creating and editing Patient cards

e General information about printing

For further information on installation and configuration please refer to the Workstation
Installation manual.

2.2 Intended Use / Indications for Use

Using the optional spirometry module and associated accessories to acquire, view, store, and
print measures and waveforms of pulmonary function. The spirometer should only be used
with patients able to understand the instructions for performing the test.

Indications for spirometry include, but are not limited to, the following:
Shortness of breath

Chronic cough

Occupational exposure to dust and chemicals

Assist in the diagnosis of Bronchitis

Assist in the diagnosis of Asthma

Wheezing

Assist in the monitoring of bronchodilators

2.3 Contraindications

Relative contraindications to performing spirometry are [AARC Clinical Practice Guideline

Spirometry, 1996 Update]:

¢ hemoptysis of unknown origin (forced expiratory maneuver may aggravate the underlying
condition);

e pneumothorax;

e unstable cardiovascular status (forced expiratory maneuver may worsen angina or cause
changes in blood pressure) or recent myocardial infarction or pulmonary embolus;

e thoracic, abdominal, or cerebral aneurysms (danger of rupture due to increased thoracic
pressure);

e recent eye surgery (e.g., cataract);

e presence of an acute disease process that might interfere with test performance (e.qg.,
nausea, vomiting);

e recent surgery of thorax or abdomen.

DIR 80012334 Ver. C 14 /95
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2.4 Important Considerations

The Spirometer should not be used if any of the following conditions exist or are thought to
exist:

e The spirometer is not regularly calibrated.

e The maintenance instructions listed in section 13 are not satisfactorily completed.

e Any part of the equipment or system is known, or suspected, to be defective.

DIR 80012334 Ver. C 15/95
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3 Installing the SpiroPerfect Spirometer

The SpiroPerfect Spirometer consists of two elements: the spirometry sensor, and the
software that runs on the computer to which the sensor is connected. Before you can start
recording spirometry tests, you need to:

e Connect the sensor to the computer.
e Configure the software.

Warm up the Spirometer
After connecting the device it is recommended to let the Spirometer warm up.
1. Connect the Spirometer to the computer.
2. Open the Spiro module.
The sensor starts to warm up as soon as the SpiroPerfect module is opened.
3. Wait for at least 5 minutes before starting a new test.

Flow sensor with USB connection:

SpiroPerfect from Welch Allyn

OEM SpiroPerfect manufactured by Medikro Oy, Finland for Welch Allyn Inc, USA.

C€u

For information on connecting the Flow sensor with USB connection see section 3.1

Flow sensor with serial connection:
SpiroPerfect from Welch Allyn

OEM SpiroPerfect manufactured by Medikro Oy, Finland for Welch Allyn Inc, USA.

C€...

The Flow sensor with serial connection is ready for use after plugging it into the
computer. No further driver needs to be installed.

3.1 Connecting the Flow Sensor with USB connection to
the Computer

If the Spirometer has never been connected to the computer before, follow the instructions
under First Time Installation. This procedure will copy and install the driver files from the
CardioPerfect Workstation Installation CD to the computer.

If the Spirometer was already installed, but is now connected to a USB port it hasn't been
connected to before, Windows shows the Found New Hardware Wizard. In this case the
Spirometer can be installed without needing the CardioPerfect Workstation Installation
CD. Therefore, follow the abridged instructions under Connecting to a different USB port.

DIR 80012334 Ver. C 16 /95
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First time installation
1. Fora USB Spirometer, you will need to install the USB Spirometer drivers if you have
not installed these already.
2. If you have a Serial Spirometer no drivers will have to be installed.

To connect the USB flow sensor to the computer:
3. Connect the device to a free USB port on the computer.

4. If you don't have the appropriate rights for installing device drivers, Windows will
display the following window asking you to type in a user name and password for a
user with sufficient rights. Otherwise continue at the following step.

Found New Hardware

You must be a member of the Administrators group on this
computer ko install this hardware:
M9458 LISE Spirormeter

ser name: ﬁ | v

Password:

’ Ok H Cancel l

Type in a user name and password for a user with administrator rights and press the
OK button.

5. The Found New Hardware Wizard window will appear:

Found New Hardware Wizard

YWelcome to the Found New
Hardware Wizard

windowes will zearch for current and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows [pdate ‘web site [with your permizsion].

Read our privacy policy

Can Wwindows connect to Windows Update to search far
software?

3 Yes, this time anly
(3 ez, now and every time | connect a device
() No, not this Hime:

Click. Mext to contitiue.

[ Mest> |[ Cancel

Select No, not this time and press the Next button.

6. The following window will appear:

DIR 80012334 Ver. C 17/95
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Found New Hardware Wizard

Thiz wizard helpz pou inztall goftware for;

LISE High Speed Senial Corveerter [for Mediko USE
Spirometer)

\'\,l IF your hardware came with an installation CD
i or floppy disk. insert it now.

wihat do pou want the wizard to da?

(®)install the software automatically [Fecommendedf

() Install fram & list o specific lacation [Advanced)

Click Mest to continue,

< Back ” MHeut » ][ Cancel ]

¢ Select Install the software automatically (Recommended).
e Press the Next button.

7. If you are installing on a Windows XP system, the following driver signature warning
window will appear:

Hardware Installation

L) E The zoftware you are installing for this hardware:
L3
|JSE High Speed Senal Converter [for Medikra USE Spironmeter)

haz not pazsed Windows Loga testing to werify its compatibility
with Windows =P, [Tell me why this testing iz important. |

Continuing your installation of this software may impair
or destabilize the comect operation of pour system
either immediately or in the future. Microsoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that haz
passed Windows Logo testing.

| LCantinue Anyway | [ STOF Installation

Press the Continue Anyway button.
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8. The system now installs the device. Please wait until the following window appears.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finizhed installing the softveare for:

IJSE High Speed Serial Corvverter [for Medikio JSE
% Spirameter)

Click Finizh to cloze the wizard.

Press the Finish button.

3.2 Configuring the Welch Allyn CardioPerfect
Workstation

After connecting the spirometry sensor, you need to configure Welch Allyn CardioPerfect
Workstation.

To configure Welch Allyn CardioPerfect Workstation for use with the sensor:
Start Welch Allyn CardioPerfect Workstation.

In the File menu, click Settings and click Spirometry.

Click the Recording tab.

Select Welch Allyn SpiroPerfect.

Click OK to save the settings.

agrONE
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4  The Spirometer Window

This section guides you through the various parts of SpiroPerfect. The structure of the
workspace is similar to the other Welch Allyn CardioPerfect Workstation modules and
conforms to the Microsoft Ul guidelines.

Figure 4.1 Main Window

Search area Toolbar Workspace Menu bar ¢— Title bar
% Welch allyn CardioPerfect f =10 x|
File Edit Mal Wiew Action Tools Help

[ Patiert | +2ECG A Exmicics ECG %Evacullect | #8 Spiometry | € 8P | [ZFin - [ Fiint Preview |

Send gdﬂep\y Y& Eonward ¥ Delete | %Sandz‘ﬁa:eive | F!efresh |” W H ey Effort - Calibrate Ea\ihralinn Log ‘ Intelpretalinn “
Famal | Ya PocketPC | Fatient Test date:
€ Fatients | 2 Search CCNV.003 - John Doe, (M), 3/27/1947 2/8[2000 4:15:11 PM
Search: FvC I SYE I My | Tlendl Measurementsl
I zl o 129 :
MHumber | Mame | 10 EffO rt
M CONV.012 Brady /T achy
% CONV.002 Ceasar. J. o selector
£ CCNYV.003 Doe. John 6]
M CONV.013 Fainting attacks "
M CONV.O0 Jongmans, Stella 4
Dﬁ CCHY.0T0  Modal tachycardia
% CONV.008 Onpmous, Amn Shortcut
0 CONY.009 Pacing problem
Dﬁ CCHY.004  Recording, Long menu
123 testrumber]
B CONVOTT WP
Graph
area
42 Within notmal limits
FlowMolume Loop j Selected FlowMalume j
q _+|| [ Intespretation: | [Ettort 4TS Selected |[FWC [FEW1  [FEW1% [FEWS  |FEVE |PEF
Prer PVC= B AL FEY = 4 700 FEWA /FC= 3 8% Urits - L L = L L Us
Type | Date & time | (2/9/2000 4:15:12 PM), "within rormal limits T = 0 é.w T
% 2/8/2000 41511 P Toag e “ 0 '
-2 10/7/1395 12.15:51 PM Interpretation Hot Confirmed
T B3935 329.33PM _
T B9 R02EAM Somment IF‘le £1511HN [, (513 43¢ [85%  |s07  [513 (106
T, 5291995121833 PM
Final - 560 470 |s4x 552 [5E0 [11.14
Lung Age: Final%Pred |- W05% [107% 103% - - nzzx
35 pears
P | |[FimaL 560 [470 [s4 [s52 [s80 [1114
|admin (Caucasian [165.2 Ibs [72 inches [ECC5/Quanjer 1993 7
Status bar — Interpretation area Parameters area
Title bar The title bar displays the name of the program. Three buttons located on

the right of the title bar can be used to maximize, minimize and close
CardioPerfect Workstation.

Menu bar The menu bar contains the File, Edit, Mail, View, Action, Tools and Help
menus. When a menu is grayed out you cannot access its functionality.
Toolbar The toolbar contains the Patient, ECG, Exercise ECG, Recollect,

Spirometry, ABP, Print, and Print Preview buttons. It provides easy access
to other CardioPerfect Workstation applications and most common tasks
in the SpiroPerfect module.

Search area The search area on the left hand side contains search and display
functionality. In the search area, you can find a patient, see the date and
type of tests recorded for a patient. You can create search patterns, so you
can easily locate frequently needed information.
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Workspace The workspace displays tests and test-related data, such as graphs and
measurements. This is where you record, view and interpret the data.

The workspace is divided into three elements:

e Graph area: This area displays spirograms and flow curves.
e Interpretation The interpretation area displays the automatic or
area: confirmed interpretation for the test, lung age and
ATS reproducibility data.
e Parameters The parameters area displays each effort and up
area: to 6 user-defined measured parameters.

Shortcut Menu In the workspace, you can use shortcut menus to access the most
common tasks. You can access these tasks by clicking on the workspace
with your right mouse button. Shortcut menus are context sensitive,
meaning that they show only relevant tasks for the area clicked.

Status bar The status bar at the bottom of the window shows the name of the user
currently logged on, the patient’s race, height, weight and the Prediction
norm used in the Spirometry test currently viewed.
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5 Customizing the Spirometry Module

This chapter shows how to adjust various settings like selecting prediction schemes,
determining which parameters to view and print, and set various display options.

Customize features in the Spirometry settings.
To open the Spirometry settings:

1. Choose File

2. Select Settings > Spirometry

The following screen appears:

Figure 5.1 Settings Screen
osertngs ol x]

.
ﬂ Spirometry
b
3 - —
s : al I \-’iewingl Palametelsl F'lintingl Hecoldingl
General
Prediction: Calibration syringe:
| ECCS/Quarjer 1993 > |a000m -
-V Parameter | Calibration reminder:
I RVE Eveny
i FIYC " Day
i+ Max[FYC, FIVC, SWC¥) 0+ wieek
* Best composite anly " Morth
—Reversibility
" Post%Pre Pressure: Flow:
s [Post-Pre)%Pre (e mbar * Lis
2 T Lim
" [Post-Pre]%Pred ' mmHg
.:[EI.:..:":' r—Final rezult " inHa Temperature——
= i+ Best effort f+ C
7 Best composite " kPa i F

()4 I Cancel Apply Help

51 General Tab

To display the General tab:

1. Choose File
2. Select Settings > Spirometry > General

The following screen appears:
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Figure 5.2 Spirometry General Tab

ol x|
,
Spirometry
b
""-"" | \-’iewingl Palametersl F'lintingl Hecoldingl
General

Prediction: Calibration syringe:

| ECCS/Quanier 1993 ~| |00 -

VT Parameter [ Calibration remindsr:

R Evenyr

T FIWE " Day

(o Max[FYC, FIVC, SWC¥) I+ Week

* Best compozite anly " Month

—Reversibility

" PostPre Pressure: Flow:

i+ [Post-Pre]sPre (+ mbar + Lis

(" [PostPre]%Pred ~ mnHg ®

r—Final rezult " inHg Temperature—
e Best effort e 'C

" Best composite " kPa CF

QK I Cancel Apply Help

Setting
Prediction
VC Parameter

Reversibility

Description
Select the prediction to use. The list contains all supported predictions.

VC parameters, FEV1% formula:
The FEV1% formula determines the calculation method for the FEV1%
value, which affects the automatic interpretation. The variable part of this
formula is the denominator; the numerator is always the best effort's FEV1
value.
To determine the way in which FEV1% is calculated, choose from these
options:
e FVC (FEV1% = FEV1/FVC)
e FIVC (FEV1% = FEV1/FIVC)
e Max (FVC, FIVC, SVC*) (FEV1% = FEV1/FVC or FIVC or SVC, the
largest)
*Note: The SVC parameter is only included if Final Result is set to
Best composite.

Reversibility is the percentage difference between pre-test and post-test
data. This measurement indicates the effect of medication on lung
function. Reversibility applies to each parameter separately.
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Final Result A patient’s best effort is a measurement calculated from a set of efforts. To
determine the method in which best effort is calculated, choose from these
options:

Best effort Defines best effort as the single best effort in a set of
efforts per effort type (best FVC-pre, best FVC post,
best SVC). This ATS-recommended method uses the
effort with the highest sum of FVC + FEV1, or the effort
with the highest SVC value. (For details, see the
document noted in reference 5.)

Best Composite  Defines best effort as a composite of the highest
parameter values across all selected efforts.

Calibration Default value for the volume of the calibration syringe. Select the Syringe

syringe Volume from the list.

Calibration Check this box to receive a calibration reminder pop-up daily, weekly or

reminder monthly.

Pressure Determines the unit of Pressure. Check the preferred unit.

Flow Determines the unit of Flow on the axis of the graph, possible options are
L/s or L/m.

Temperature Determines the unit of Temperature, possible options are °C or °F.

5.2  Viewing Tab

To display the Viewing tab:

1. Choose File
2. Select Settings > Spirometry > Viewing

The following screen appears:
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Figure 5.3 Spirometry Viewing tab

ol x|
:
ﬂ Spirometry
vl General |F'arameters| Printingl Hecordingl
General

Parameters in: r—Effort label:
i+ Columnz * Time
[ Rows " Mumber

rShow Predictive 24 iz Position
[v Paints + Top
v Cuive " Bottom

r—Trending: r—Table Color Scheme:
(% reference value |Welu:h Allyr ﬂ
" % predicted

Scheme editor
[ Wanual selection of the best effort
[v Digplay &T5 Acceptability per effort
[w Superimpoze P curves
[ Display Lung Age
] I Cancel Apply Help

Setting
Parameters in

Description
Columns or Rows. Changes the layout of the six parameter table.

Show Points and/or Curve.

Predictive If Points is checked, predictive points display and print in the FVC graph,
Predictive points definition see page 93.
If Curve is selected a prediction curve will be displayed in the FVC graph.

Trending % Reference Value or % Predicted. When % Reference Value is selected,
parameters values are graphed as a percentage of the selected reference
value. When % predicted is selected, parameters will trend as a
percentage of predictive values.

Manual If checked, you are allowed to manually select the best effort, when the

selection of Final Result is set to Best Effort.

best effort

Display ATS If checked, a row or column appears in the Parameter and Measurement
Acceptability tables displaying whether or not each individual effort meets the ATS 2005
per effort acceptability criteria.

Superimpose
FV Curves

If checked, curves are offset on the graph. If unchecked, all curves are
superimposed.
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Display Lung
Age

Effort Label

X Axis Position

Table Color

Scheme

Scheme Editor

If checked, the estimated Lung Age will be shown while viewing a test and
in the printed reports for patients of 20 years or older. For details, see Lung
Age, page 71.

Time or Number. If Time is selected, each effort is labeled with the time it
was recorded. If Number is selected, each effort is labeled with a number
and stage. For example, FVC Pre3 means it is the 3rd effort of a FVC test.

Bottom or Top. If Bottom is selected, spirograms are displayed with the
horizontal axis at the bottom of the graph. If Top is selected spirograms
are displayed with the horizontal axis at the top of the graph.

Defines the background color and font type and color of the Spirometry
module. The default setting is Welch Allyn. To customize the settings
select User Defined from the drop-down menu.

Select the User Defined option from the Table Color Scheme drop-down
menu. Once selected, the Scheme Editor button becomes highlighted.
Click on the Scheme Editor button. The Styles properties editor dialog box
appears. You can customize the properties for the Spirometry module in
the Styles properties editor dialog box.

53 Parameters Tab

To display the Parameters tab:

1. Choose File
2. Select Settings > Spirometry > Parameters

The following screen appears:
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Figure 5.4 Spirometry Parameters tab

o [m] 3]
_ Moduss | -
Modules ‘]i Spirometry
0
. .0 Generall Wiewing | F'rintingl Hecordingl
e Parameters tMeasurements Six parameters Frinter | [ selection:
FC [w v v Maone
FEV1 v v ¥l
FEV1% v v ¥l Al
FEV1/FVC i r [
FEVILE O ] | |hverted ‘
FEVZ i r [
= [ v v Diefault ‘
FEVE i r [
FEVE v v ¥l
FEVO5% i r [ -
FEv2Z C r Ll
FEVaZ C r Ll
FEVEZ C r Ll
FEVEZ C r Ll
FEVA/FEVE C r L
PEF v v v
FEFZ5 i r [
FEF50 i r [
FEF75 i r [
MEF25 i r [
MEFED i r [
MEF75 i r [
FFFR.7R [l r - =
0K I Cancel | Apply | Help

Select parameters for three categories:

Setting Description

Measurements  Parameters selected in the Measurements column are displayed in the
Measurements Tab of the SpiroPerfect module.

Six parameters  Parameters selected in the Six parameters column are displayed in the six
parameters table of the module’s Parameter area. A maximum of six
parameters can be selected per test type. For FVC, a minimum of three
parameters is required.

Printer Parameters selected in the Printer column are printed on the reports.

Selecting more than 15 parameters for
printing may result in the list of printed

A WARNING parameters being truncated on all but the
Best FVC report.

Parameters Measured

FVC testing

FvC FIVvC FIvl FIV1% FEV0.5 FEV1
FEV2 FEV3 FEV5 FEV6 FIV0.5 FEV0.5%
FEV1% FEV1/FVC FEV2% FEV3% FEV5% FEV6%
PEF FEF25 FEF50 FEF75 FEF0.2-1.2 FEF25-75
FEF75-85 PIF FIF50 FEF50/FIF50 FEV1/FEV6  FET
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MEF25 MEF50 MEF75

SVC testing

SvVC ERV IRV \a) IC BF

MV Tin Tex Tin/Tex

MVYV testing

MVV MV VT BF DFRC

Selection

None Blanks all previously selected parameters boxes in the Measurements and
Printer columns. It does not affect the Six parameters column.

All Selects all parameters in the Measurements and Printer columns. It does
not affect the Six parameters column.

Inverted Deselects the selected parameters, and selects the parameters that are
not for the Measurements and Printer columns. It does not affect the Six
parameters column.

Default Selects factory Default parameter selections for the Measurement, Six

parameters and Printer columns.

54 Printing Tab

A color printer is recommended for printing Spirometry reports.
Printing these reports with a black and white printer can lead to
L \  WARNING J P y

confusion as it is not easy to identify which curve is a Pre and
which is a Post effort.

To display the Printing tab:

1. Choose File
2. Select Settings > Spirometry > Printing

The following screen appears:
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Figure 5.5 Spirometry Printing tab

ol x|
i
- ﬂ Spirometry
vl Generall \-"iewingl Farameters Ell Hecordingl
General
—Default report template
Selected:
[ Al plus best effart FYC
[ Best FWC
[ Best My
[ BestSWC
[ Best Three FWC
[ Measurements My
[ Measurements SYC
[ Measurements YT
[ Social Security
[T Trend
Shaw On Repart Graph zcaling
[ Unconfimed " Fixed
[v Confirmed by
s Auto scale
[ Pritit in calor
] I Cancel | Apply Help
Setting Description
Default report A list of available templates used for printing reports.
templates To print multiple reports, select the preferred formats from the list.
Show on Unconfirmed If checked, Unconfirmed is printed on the reports if the
Report test is not yet confirmed.

Print in color

Graph scaling

Confirmed By  If checked, Confirmed By is printed on the reports. It
provides a space for the clinician’s signature.

If checked, the spirometry reports are printed in color when using a color
printer.

Select the type of scaling (graph resizing) to use when printing
volume/time curves.

Fixed scale (volume 10 mm/L, time 20 mm/sec, flow 5mm/(L/s))

Auto scale—both x and y-axes (volume and time) scale automatically.
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55 Recording Tab

To display the Recording tab:

1. Choose File
2. Select Settings > Spirometry > Recording

The following screen appears:

Figure 5.6 Spirometry Recording tab

=10l x|
todules
==

Spirometry

Generall \-"iewingl Farameters | Printing

—Sensar type Connected ta
" Spiro Perfect VCT 400

i+ ‘Welch Allun SpiroPerfect

Automnatic j

r—LCalibration pratocol

{* Sinagle calibration stroke protacol

" Three calibration stroke protocal (1.2 and 3 seconds flow)

rCalibration Errar Tolerance
* Social Security (1 %)

" Standard [3 %)

rIncentive file
| CAPROGRA™IMCARDIO 1M DWW odules Fireman. swi J

Senzor calibration informatior

Lot Code 24 j Calibration Code IS HY Confirn Code |

[~ ATS zound notification

] I Cancel Apply Help
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Setting
Sensor Type

Connected To

Calibration
protocol

Calibration
Error Tolerance

Incentive file

Description
Select Spiro Perfect VCT-400 or Welch Allyn SpiroPerfect.

Select the COM port to which the Spiro Perfect VCT-400 is connected.
Select the port to which the Welch Allyn SpiroPerfect sensor is connected.
The port for the Welch Allyn SpiroPerfect sensor with USB connector is
automatically detected.

Select the Single calibration stroke protocol (this is recommended for the
Welch Allyn Spiro Perfect)

or

Select Three calibration stroke protocol (1, 2 and 3 seconds flow)

Select Social Security (1%) for increased accuracy required by US Social
Security Administration guidelines

or

Standard (3%)

Select the file that is used for the incentive screen for testing the pediatric
population.

Sensor Enter the Lot code and the Calibration code and Confirm. For more
calibration information see page 34. If the Spiro Perfect VCT 400 is selected this area
information is not applicable.

5.6 Customize the spiro.txt file

Statements used in the Comment editor can be customized. Please refer to the Workstation
manual for general instructions on editing this file.

Medication list

In addition to the pre-defined comment and interpretation statements, this file also contains
the medications shown in the medication list. These items are immediately followed by an
asterisk (*) in the spiro.txt file.

Note: If no spiro_cmt.txt file is available the spiro.txt file is used.
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6 Ambient Settings /Temperature, Humidity
and Pressure

Adjust the Ambient Settings (the temperature, humidity and air pressure) before calibrating
the flow sensor.

é Adjust ambient settings before calibrating the flow sensor. If
the ambient settings are not adjusted before calibration, the
CAUTION device will not be properly calibrated and could give false
readings.

You must recalibrate if there is a significant change in the
ambient settings.

Ambient settings are stored locally by the program and passed
on to the flow sensor before each measurement. This means
that when using different PC's with the same flow sensor you
have to set the ambient settings on each PC before starting the
measurements. Also, when another person logs in to the PC,
he/she needs to enter the ambient settings.

6.1 Why the Workstation needs Ambient Setting
Information
Ambient settings information is necessary for calculating the Ambient Temperature Pressure

Saturation (ATPS) to Body Temperature Pressure Saturation (BTPS) correction in the Flow
sensor.

6.2  When to Adjust the Ambient Settings

Adjust the ambient settings:

o Dalily, the first time logging into the Spirometry module.

¢ When ambient settings have changed significantly during the day.

¢ When the same flow sensor is used on different computers. In this case, adjust the
ambient settings on each computer.

o Before a calibration takes place, in the pre-calibration window.

6.3  Adjusting the Ambient Settings

1. Make sure the SpiroPerfect module is loaded.
2. Press F9 or choose Ambient settings from the Tools menu.

The following screen appears:
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Figure 6.1 The Ambient settings dialog box

Ambient settings E|

Ambient settings:

Temperature:; |ﬂ T

Hurnidity: G0 i
Pressure; 1040 mbar
ak. Cancel

1. Enter the Temperature value. (The value for the ambient temperature.)
2. Enter the Humidity value. (The value for the ambient air humidity.)
3. Enter the Pressure value. (The value for the ambient barometric pressure.)

Tip:
In the spirometry settings, the ambient units for temperature and pressure can be changed.

Tip:
There is an additional option available to update the Ambient settings:
1. Select Calibrate located on the Toolbar (or press F10)
2. Enter the ambient setting information in the Pre-Calibration dialog box. Updating
ambient settings is recommended when a calibration is going to be performed.
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7 Calibration of Flow Sensor

The American Thoracic Society and Welch Allyn recommend
& CAUTION " 'c Society y

calibrating spirometers every day before use

Welch Allyn guarantees accurate calibration only with the use of a Welch Allyn 3L calibration
syringe. Although SpiroPerfect provides other calibration syringe volumes for use, Welch
Allyn is not responsible for the system’s accuracy if these syringes are used.

Flow Transducers
Flow Transducers are manufactured to high precision and it is not necessary to calibrate the
spirometer system with each Flow Transducer separately.

Consult Accompanying Documents
CAUTION Perform a new calibration when using a new lot of Flow
Transducers.

7.1 Preparing calibration

Calibration Protocol

SpiroPerfect supports two calibration protocols:
e Single Stroke Calibration

e Three Stroke Calibration

The calibration protocol can be set on the Recording tab in the Spirometry Settings. See
section 5.5 Recording Tab.

To calibrate the Welch Allyn SpiroPerfect flow sensor it is strongly recommended to use the
Single Stroke Calibration Protocol while calibrating. This method will increase the accuracy of
the flow sensor. To calibrate the Spiro Perfect VCT-400 use the Three Stroke Calibration
Protocol for the best results. The protocol can be changed in the spirometry settings.

Warm up the Spirometer
Before calibrating it is recommended to let the Spirometer warm up. If the Spirometer has
already been used shortly before calibration, this warm up period is not needed.
1. Connect the Spirometer to the computer.
2. Open the Spiro module.
The sensor starts to warm up as soon as the spirometer module is opened.
3. Wait for at least 5 minutes before starting the calibration process.

7.2 The Calibration Process
Make sure the Spirometer is plugged in before continuing.

1. To start the calibration, select the Calibrate button located on the Toolbar (or press
F10). The following dialog box will be presented to configure the calibration process.
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Figure 7.1 The Pre-calibration dialog box

Pre-calibration x|
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Lot Code

Calibration Code
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Calibration Emror Tolerance:
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1040 rbar
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Fill in the appropriate settings. For a description of the options see the following table.

Setting
Lot code

Calibration
code

Description

Enter the Lot code for the Flow transducers located on the box the
Transducers came in.

Enter the Calibration code for the Flow transducers located on the box the
Transducers came in. See example of a schematic cutout of the label from
the Flow transducers box below.

CALIBRATION CODE HEABERHHE
LOT| ## QTY 100

THATEHE

Note: the sensor calibration information can also be set in the
Spirometry settings (recording tab). Please make sure that Lot code and
Calibration code are still accurate before calibrating.

Syringe Volume

Current
Calibration
Factor

Vica test:
If the VCT400 was selected the Lot Code and Calibration Code options
are not applicable and grayed out.

Select the appropriate Syringe Volume.

Tip: See page 22 on how to change the default setting.

This value cannot be changed and indicates the correction factor applied
to the calibration data from the previous session. Once the calibration is
performed, this value will be updated. The factor displayed is the average
of the inspiration and expiration calibration factor.
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Setting Description

Calibration Select the measured calibration accuracy to be within 1% or 3% of the
Error Tolerance syringe volume.

Tip: See page 30 on how to change the default setting.

Temperature The ambient temperature

See Operating Environment Specifications on page 80
Humidity The ambient humidity

See Operating Environment Specifications on page 80
Pressure The ambient pressure

See Operating Environment Specifications on page 80

For the ambient settings pressure field please enter the

pressure as given by a barometer in the immediate vicinity.
WARNING

Do not enter the normalized sea-level pressure as commonly

listed on internet sites on meteorological data resources.

2. Press the Next button to continue.
The following screen appears depending on your setup:

Figure 7.2 Calibration window

]

@
Caltuwe Cotngmon Lo et

Mmes D0 G Seengs ke MMal  Protoo Sege e Tae et |

Beneath the Calibration window the calibration instruction and message window is
displayed, giving instruction for the calibration procedure.

Note: Please check the calibration and lot code if you cannot continue to the
Calibration window.

3. Connect the syringe to the new flow transducer.
4. Fill the syringe by pulling the plunger completely out.
5. Press the Calibrate button in the window.

6. Wait until the messages ‘Initializing sensor. Opening sensor, please wait...’
disappears.
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Figure 7.3 Start Calibration
x|

Thiz iz a single flow calibration. Please attach a new flow transducer ta the syringe.
Start with the springe filled as illustrated in thiz picture and press OK when ready to start the calibration.

LCancel |

7. Verify the syringe is completely filled and press the OK button.
Note: If the syringe was emptied before calibration, the “No valid stroke recorded”
message will appear.

8. Follow the instruction on screen. The blue calibration bar can be used as a guide line
by giving you an indication of the speed.

Figure 7.4 Calibration bar
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Caiibration instructions and message windaw

Fallow the blue bar =
Do not stop betwveen & push and a pull of the plunger.

[140mbar  [z0.0°C [60%  [Syringe volume 3000 ml [Protocol: Single Flow [Calibrating  [Excpiratior [Attempt 1

For a single flow calibration protocol

Push the plunger entirely in and pull the plunger out as far as possible, while following
the blue bar as closely as possible. The calibration procedure will stop automatically,
and inform you of the results.

For multiple-stroke calibrations
Push the plunger entirely in and pull the plunger out as far as possible, three times,
while following the blue bar as closely as possible.

At the end of each stroke a message appears; you can either choose to accept the
calibration stroke or redo the last stroke.
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Figure 7.5 Accept stroke

x

Press YES to accepk this stroke, and perform the next one.
To redn the strake press MO, and ko stop calibrating press CARMCEL.

Mo | Zancel |
The following options apply:
e Yes: Continue to the next stroke, or show calibration results.
e No: Redo the current stroke with the same speed.

e Cancel: Stop calibrating. The sensor will not be calibrated.

9. If the calibration was successful this will be displayed. You can either accept the
results or recalibrate. If the ATS standard has not been met you have to recalibrate.

e See the following section on how to deal with the results.
¢ If you have pressed the Recalibrate button: Press the Repeat Calibration button in
the Calibration window and follow the instructions above from step 6.

Note: If you have trouble getting the results within the Calibration Error Tolerance try:
e waiting 1 second between emptying and filling the syringe.
e asingle flow calibration before the three flow calibration, if the three flow
calibration is unsuccessful
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7.3 View Calibration Results

After calibration the Verify Calibration Results window will appear.

Figure 7.6 Verify Calibration Results
(|IExp.%] + [Insp.%]|)/2=Abs.Avg.%

Yerify Calibration Results

Syringe Volume | 3000 wml
Humidity [ kT4
|Stroke N [ L/ ExpVol

[1. 05 |33
2 1 |3016
3. 13 3011
|Averanss |33
| - Note:

Abs.Avg% should be:

- <1% to meet the social

security standard

- <3% to meet ATS standard

Social security standard has been met ( < 1%)
ATS standard has been met ( < 3%)

Each row gives the result of a stroke, the last row gives the Averages. The following columns
are given:

L/s Results per stroke:
The speed in the L/s plunger should be moved, as indicated by the blue
calibration bar during the strokes.

Exp. Vol The expiration volume reached by pushing in the plunger.

Exp.% The expiration deviation from the actual volume in percent.
Insp. Vol The inspiration volume reached by pulling out the plunger.
Insp.% The inspiration deviation percentage

Avg.Vol The averages of inspiration volume and expiration volume.

Abs.Avg.% | The absolute average deviation percentage between inspiration volume and
expiration volume.

The Averages row gives the averages reached for all strokes. Please refer to this row for
improving the calibration results.

After you have accepted the results you can view these values in the table below the graph by
selecting the Calibrate Results button.
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Figure 7.7 Single stroke calibration window with calibrated results

100 x|
n ?ﬁ [ n h? hn? 6 I‘;ﬂ
|
|
N
i
i !
:f
)l
Figure 7.8a Single stroke calibration Figure 7.8b Three stroke calibration
Stroke Mr Lis Exp ol Exp% Insp Mal Insp.% Ava Vol Ava % Shioke N Lis Expiiol Exp % Insp Vol Insp.% A Wal g %
1 1 24955 0.03 2850 033 2934 018 1 0§ 3007 023 2987 043 2997 010
Averages 2999 003 2990 033 2334 018 2 1 3004 013 3008 027 3008 020
3 3 2352 027 3067 1.90 3024 082
Aueranes 3001 003 am7 067 2003 030
Calibrated results table:
Selection Description
Calibrate Press the "Calibrate" icon when you are ready to start the calibration

process. After one calibration, the icon label changes to ‘Repeat
Calibration’. It is recommended to repeat the calibration more than once.

Calibration Press the Calibration Results icon to view the results of the calibration.
Results This can only be viewed between calibration attempts.

Calibration Press the Calibration Logs icon to view previous calibration attempts.
Logs

Print Log Press Print log icon to print the currently selected or displayed log.
Print Preview Press Print Preview.

The Print dialog box appears.
Press OK on the Print dialog box to the view the calibration results before
printing.

Done Press Done to exit the Calibration window.

7.4 Error Messages Associated with Failed Calibration

Figure 7.9 No valid stroke recorded

warning x|

Mo walid calibration stroke recorded.
T Please press OF to redo this stroke, CAMCEL to abort:

Cancel |

When the calibration attempt was not valid or if the volume read back by the sensor is not
within 35% of the selected syringe volume, the calibration fails.

This message also appears if the calibration attempt was performed in the wrong order, first
emptying the syringe instead of filling it before starting the calibration.

=l
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Caution 'tisthe user’s responsibility to determine whether to accept or reject
failed calibration data. If the device does not pass calibration it could

give false readings.

Note for Spiro Perfect VCT-400 users:
If the following message appears after a failed calibration, turn the Vicatest sensor off and on
again and proceed with a new calibration.

Figure 7.10 Old calibration factors warning message

X

Cld calibration Fackors cannat be retrieved From Spiro Perfect,
Please switch the device off and on and try another calibration.

7.5 Calibration log

Figure 7.11 Calibration log window
@ cabanniaa ~lDix|

Dt

User Lo ahon Devca © bup CF up 50 Do CF D 50 | Coltusted
CARDIT e Cante. wiekch A (=5 Wi BE3E W
= ™~ 1
Cade.
o

Use the Calibration log to view calibration information of current and previous calibration
efforts. Each time the sensor is calibrated, results are stored in the calibration log. Select a
calibration effort from the list to see the curve that belongs to it.

Calibration Log

Selection Description

Date & time Date and time of the calibration.

User Name of the user that performed the calibration.
Location Location specified in the general settings.
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Device ID The spirometry sensor hardware used.

Insp. CF The Calibration Factor of the inspiratory strokes.

Insp. SD The stroke difference between the inspiratory strokes.

Exp. CF The Calibration Factor of the expiratory strokes.

Exp. SD The stroke difference between the expiratory strokes.

Calibrated A check mark shows if the sensor was actually calibrated (yes) or only a

log entry was saved (no).

To view the calibration log:
1. Choose Tools
2. Select Calibration log
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8 Recording Spirometry Tests

Various types of efforts can be recorded with the Spirometer module:
e FVC: Forced Vital Capacity.

e MVV: Maximum Voluntary Ventilation.

e SVC: Slow Vital Capacity.

The following tags can be assigned to each effort:
e Pre
e Post

When recording a post stage effort the medication administered to the patient can be entered.

8.1 Record a Spirometry Test
Follow these steps to record a test.

1. Inthe Workstation, find or create a patient (see the Workstation manual for
instructions).

2. Choose Spirometry, #Spiomelty | ted in the toolbar at the top of the screen.

Tip:
The following screen appears if a new effort or test is being added to the patient’s
profile within 24 hours since the last test or effort.

Figure 8.1 Warning window

Fatient has already recorded one Spiro test today!
& How do you want to proceed?

Create Mew Test Cancel

[

Caution Usenumerals only to set the date format. Alpha
characters cannot be used in the date field.
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Figure 8.2 New spirometry test window

Mew spirometry tesk El

—FPatient infarmation:

Height: Wwigight: Birth date b /dAymy
| 70 inches |207.2 bz | 212194 ﬂ
Gender; Race:
| b ale ﬂ | Caucazian ﬂ
I Smoker [T Asthmatic

— Test information:
Refering physician: Speciality:

| Arw

Prediction narm;

ol =

| ECCS /Quanier 1993 ~|

Ambient settings |

Mexst » |

3. Complete Patient information fields in the New spirometry test window. Check the
Smoker and/or Asthmatic boxes if applicable.

4. Select the Specialty and Referring physician, by whom the test was ordered.

5. Select the Prediction Norm for the test.

é Caution

To obtain predictive values for certain parameters, the patient’s age,
gender, race and height must be entered into the Patientcard dialog
box (Choose Edit>patientcard or Alt+P), otherwise no predictive
data is reported. The patient’s weight is only obligatory for certain
prediction norms.

Note: If patient data is missing these will be displayed in red in the
New spirometry test window. You must fill in the blanks before you
are able to continue.

The Norm Profiles (see section 12.1) indicate valid demographic
ranges for each norm.

6. Select Ambient Settings. If the humidity, temperature or pressure have changed
since the last calibration, adjust as necessary.

DIR 80012334 Ver. C
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7. Select Next
The following screen appears:
Figure 8.3 Recording window
oo k]
@ [p R & & B X 4
[ -] Medcsion Dasage & nt
Tip: .
Double click on the ‘ .
left graphic to expand ) .
it to full window size. : .
Double click again to NI R £
reduce it to half > .
window size. : ‘
;:modmm: L =] W 0 m L] Peproduckdty:
8. Select the effort type to perform by selecting the FVC, SVC or MVV.
9. Select the effort stage. If you have selected Post, enter the medication dosage and
unit.
Note: The medication and dosage fields are only active if a post-effort is selected.
Post-effort is only available after a pre-effort has been recorded.
10. Select the type of curve from the drop-down menu located at the bottom of the right
graph.
Figure 8.4 Type of Curve menu
Wolurne/Time
Molume/Time.
Flowd Tirme
Incentive
11. Instruct the patient to hold the SpiroPerfect sensor still.
Note: Make sure the rear of the flow-tube is not blocked. The extra resistance will
result in faulty measurements.
12. Select Record to start recording.
13. Ask the patient to perform the effort according to the appropriate procedures. See
section 8.3.
14. When the patient has completed the test, select Done. The recording window closes

DIR 80012334 Ver. C

and the main view displays all efforts of the recorded effort stage (Pre/Post).

Note: The effort along with six corresponding parameter values are displayed in the
parameters area.
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15. The status bar of the Recording window displays, ATS acceptability criteria met,
duration of the effort, number of FVC, SVC and MVV efforts completed in a test and if
the reproducibility criteria are met.

16. When the patient finishes testing, select Done. The Spirometry view appears
displaying all the efforts.

8.2 Incentive Screen

The incentive screen is used to encourage pediatric patients to blow into the flow transducer
the best they can.

To display the Incentive screen:
Select the Incentive button from the Recording/Test toolbar

or
Select Incentive from the Type of Curve drop-down menu

The following screen appears

Figure 8.5 Recording window with incentive screen selection

[T =lolx]

@ r F m g 8 x| 4
Placord s L MW lrcenirer | Contant Dore

e K3 Medcation: r Diozage & Unt:

1y

Note: Incentive screen

The fireman extinguishes the
fire if the patient’s effort
reaches 80% of the predicted
for PEF & FVC values. If the
patient’s effort is below 80%,
the fire is not extinguished.

Incnive

Pasprmeires. PV FEVI  |FEvD5 |FEvZ  |FEWS  |PEF
Unis L L I [ I 3
Caapo 1581 591 [am |37 [ses |

Dbt vakse. s g z y

TFiedcled

TS Craration: P 0 w0 M 0 Feaproduchilty: FYC Fre not met

To remove the Incentive screen:
Select Volume/Time or Flow/Time from the Type of Curve drop-down menu or select the
FVC, SVC or MVV button.

Note: If the patient's demographics are outside of the Prediction norm demographics no
prediction values will be calculated. The incentive screen will not operate without predicted
values, but will be visible.
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8.3 Patient Procedures

é Patients may become faint, light-headed, dizzy, or short of
breath during spirometry testing. Watch patients closely. If they
WARNING choose to stand during testing, keep a chair immediately

behind them. If there is any reason for concern, stop the test
and take proper action.

Recommendations

Practice the procedure with the patient before recording the
effort.

American Thoracic Society recommends ending recording
after eight successful FVC efforts to avoid fainting.

To prepare patients for any spirometry test, explain the entire procedure for the type of effort
you want them to perform. Remind patients that the test is painless. Demonstrate at least one
effort for the patient.

The accuracy of a spirometry test is highly dependent on the patient's understanding and
cooperation. So, be prepared to coach and encourage the patient with your “body language”
and your words — for example, "Blow, blow, blow, keep blowing until you can't blow out any
more” — to ensure a good effort with reproducible results.

Instruct patients to do the following:

e Loosen any tight articles of clothing that might constrict lung function, for example, a tight
belt, tie, vest, bra, girdle, or corset.

¢ Remove any foreign objects from the mouth, including loose dentures.
e The use of a nose clip is highly recommended. If used, check for proper fit.

e Place lips and teeth around a new flow transducer, sealing their lips tightly around the
transducer. Grip slightly with teeth in the groove.

o Keep tongue away from the flow transducer to avoid blocking it.

o Keep the rear of the Flow sensor free.

Keep chin up so as not to restrict the airway.

Once the patients have the flow transducer in place, ask them to perform the effort using the
guide below for the patients’ predicted performance effort breathing instructions.

Note: Place the mouthpiece in the patient’s mouth after stabilization.
For an FVC effort, instruct the patient to:

1. Breathe in (until the Total Lung Capacity is reached).
2. Blow out forcefully (until the Residual Volume is reached). Allow sufficient time.
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For an FVC loop, instruct the patient to:

1. Breathe in (until the Total Lung Capacity is reached).
2. Exhale forcefully (until the Residual Volume is reached)
3. Breathe in forcefully (until the Total Lung Capacity is reached). Allow sufficient time.

_Or_

Start normal breathing (tidal breathing).

Breathe out (until the Residual Volume is reached).

Breathe in forcefully (until the Residual Volume is reached). Allow sufficient time.
Exhale forcefully (until the Total Lung Capacity is reached).

el S

For an SVC effort, instruct the patient to:

Start normal breathing (tidal breathing).

Breathe in calmly, (until the Total Lung Capacity is reached).

Exhale calmly, (until the Residual Volume is reached). Allow sufficient time.
If necessary, repeat steps 3 and 4.

pwnNpE

Steps 3 & 4 can be reversed, meaning: a maximum expiration followed by a
maximum inspiration.

For an MVV effort, instruct the patient to:

Breathe in and out forcefully at a pace of approximate 30 breaths per minute (2 seconds per
complete breath) for 15 seconds (the program automatically stops gathering data after 15
seconds).

About Quality Feedback
The spirometer provides two kinds of quality feedback: effort-quality messages and test
quality grades, as described in the following sections.

About Effort-Quality Messages

One of the following effort-quality messages appears on the screen after each effort is
completed. These messages indicate whether an effort was acceptable and reproducible,
and if not, what the patient needs to do differently.

The term “match” here means “variation” or “difference with respect to best test.

Effort-Quality Message Criteria

Don't hesitate Back-extrapolated volume > 150 mL or 5%, whichever is
greater.

Blast out faster PEF time > 120 ms.

Blow out longer FET < 6.0 seconds, and end-of-test volume > 100 mL (invalid
FEV6).

Good effort Effort meets above criteria.

No plateau > 25 mL within the last second of exhalation

8.4 Deleting an Effort
You can easily delete an effort after recording it.
To delete an effort:

Option 1: In the Recording Test window
1. Select Delete
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The following screen appears

Figure 8.6 Confirmation dialog box

Confirmation E|

\:{‘) Are wou sure you wank to delete the current effort?

(04 | Cancel |

2. Select Ok

Option 2: While viewing the test

Highlight the effort to delete in the Parameters area, located in the lower right side of
the of workspace window. See Figure 4.1 Main Window

1. Select Action> Delete Effort or Ctrl+D, located on the menu bar, the confirmation
dialog box appears. See Figure 8.6.
2. Select OK

8.5 Add or Change Information in the Comment Editor

When creating a new spirometry test, the SpiroPerfect offers space for adding or changing
comments, while recording.

To add or change comments:
1. Choose Patient, and start a new Spirometry test

2. Select Next
3. Select the Comment button from the toolbar.
Note: The Comment editor is displayed containing previously added comments.

4. Select interpretations and or medication from the statement tree on the left side, or
type in comments in the comment pane.

5. Select Save
The Recording/Test window will appear again.

The comment editor is also available form the menu bar, select Edit comment from the Action
menu or type CTRL+T.
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9

9.1

Viewing Spirometry tests

View a Spirometry test

To view a spirometry test:

1.

2.

9.2

Select a patient. The patient’s previously recorded tests
appear in the test list.
From the test list, select a spirometry test to view.

Note: Spirometry tests are indicated with a LL
SpiroPerfect launches and the test is displayed in the
workspace.

Use the tabs and the Effort selector (in the toolbar) for
selecting information to view.

Setting the Best Effort

Follow these steps for setting the Best Effort:

1
2
3.
4,
5
6

7.
8.

9.

Choose File

Select Settings > Spirometry

Select the General tab

Under the Final result, check Best effort
Select the Viewing tab

Check Manual selection of the best effort

Figure 9.1
Patient list database

&7 Fatents I 4 Search
Search
x| @ Go
humber | Name [ Bithdate =~
HFCONV.0TZ Brady /Tachy 2171962
x|

1281921
1-1-1930

b
5 CONV.020 Doe, Jane
% Pockst_. Dos, John 1411968
T COMV.013 Fainting attacks

% CONV.001 Jongmars, Stela 1751971
5 CONV.0T0 . Nodal tachycardia

M CONV.ODB Orymous A 2381351
T COMYV.009 Pacing problem

G CONV.008 Recording, Long 111963 _ILI

] 3

Type | Date & lime |
2972003105321
297:200310:3211
522003 11:52.25
32-2000 161511
7101335121551

53.‘32<

13-6-193515:28:33
126199530233
235-19351216:33

EXCEEN

Note: This action is not available if “Best composite” is set as Final result in the

Spirometry General Settings.

Select Ok. The Spirometry settings window closes
Set the effort selector to pre or post, see Figure 9.3.
Select the pre effort you consider best.

10. Next, from the menu bar, select Action> Set Current Effort As Best
11. Repeat steps 8-10 for the post effort selection.

9.3

View and Add Information to a Test

To view and/or add information to a test:
e Select Tools > Information

The following screen appears

DIR 80012334 Ver. C
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Figure 9.2 Information dialog box

Information X |

R eferring physzician:
Recorded by:
Location:

Comment:

k. Cancel Help

To enter comments:
1. Type comments in the Comment section
2. Select OK

9.4 Test Modes and Tabs

There are four views available from the Effort selector in the toolbar:

All Efforts: view and compare all efforts of
current test.
Figure 9.3 Effort selector )
Pre: view and compare only the pre
efforts of current test.

Post: view and compare only post
efforts of current test.

Final Result

Final/Best result: view and compare only the best
effort/ final result of current test.
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Figure 9.4 Five tabs
R/C | svC | M | Trend | Measuements |

Tab Description
FvC Select to view only the currently selected FVC efforts
A flow/volume curve of the current FVC effort and the flow/volume curves
of all selected FVC efforts. The dotted line marks the predicted values.
svC Select to view only the currently selected SVC efforts.
A spirogram for the current SVC effort.
MVV Select to view only the currently selected MVV efforts.
A spirogram for the current MVV effort.
Trend Select to view only the trends to a maximum of six parameters.
Trends of the FVC effort of the test.
Measurements Select to view all the parameters calculated of all effort types.

All parameters values based on user settings for each stage and effort.

DIR 80012334 Ver. C
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9.5 Common Features for each Tab

Figure 9.5 Tab overview

FvC | SWC I Mg I Trendl Measurementsl
124 124

104
2] Wyithin narmal limits
Flaw A alume Loop ﬂ Selected Flow Y alurme ﬂ
Interpretation: | | Effark ATS | Selected | PVC FE'1 FEM1% | FEW3 FEVE PEF
Prez F¥C=5.6L FEV1=4.7L FEV1/F¥C=83.9% Units N L L % L L Lis
Within normal limits
ECCS/Quanier |- 5.3 441 81 % - - 995

Albuterol 1933

Beclomethasone™ [Fre 4:15:12 Py 84 %
B Fre 4:15:11 PhNa v |513 434 85%  |B07 513 10.95

Interpretation Confirmed on 8/4/2006 1:22:22 P
Final ° 560 470 84 % 5.51 5.60 11.14
Comment: R R - -
8-2-00 16-18 Final%Pred 105% (107 % (103 % M2 x
=] |[FiNaL |56 47 54 55 56  [111 |

View multiple flow/volume curves of one test

It is possible to view and compare multiple efforts previously recorded in one test. The right
hand side of the window displays a flow curve of all selected efforts. The left hand side of the
window displays the flow curve of the currently selected effort.

To view multiple efforts in one flow/volume graph:
1. Inthe Spirometer window, move the mouse arrow to the Parameters table.
2. Check the box of each effort to view in the Selected row/column.
3. Uncheck the boxes of each effort to hide it from view.
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95.1 Parameters Area

Figure 9.6 Parameters Table

[|Pre 4:15:12 Phs

Eftort ATS | Selected  |FWC FE'1 FEV1Z | FEW3 FEVE FEF
Units L L 4 L L Lis
ECC5/Quanjer 5.3 4.4 a2 E - - 3.95
1933

Mo
Mo v B3 4,34 a5 % R.O7 B3 10.96

560 4.70 a4 X 5.51 5.E0 11.14

FinalZPred

—
=
Ca
s

105 % 107 % 112 =

|FIN;‘-“-.L

|5.E 4.7 24 5.5 BB 11.1

Selection

Parameters
area

Effort

Description

The Parameters area holds the parameters table. It is displayed under the
FVC, SVC MVV and Trend tabs.

The Parameters table lists up to six user-defined parameters. See page 26
to select the parameters.

The following information is displayed in the table:
. predictive norm
ATS acceptability criteria
predictive values per parameter
effort stage & parameter value
final result parameter values
% predictive
% change (in “All efforts” and “Post"view)

The color in front of the effort name corresponds to the color of the curve in
the graph.

Select the check box in the selected row or column and the curve is
displayed in the graph. You can select to show the parameters in rows or
columns in the settings menu>viewing tab, see page 24.

Deselect a check box and the curve is hidden.

9.5.2 Interpretation Area

The interpretation area displays automatic or confirmed interpretation, medications,
comments, lung age (if enabled in the settings), and reproducibility information. See page 61
for more information.
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Figure 9.7 Interpretation Area

Interpretation: -
Pre: PYC=5.60L FEV1=4.70L FEV1/FWC= 83.90%
[248/2000 4:15:12 PM]. within normal limits

[nterpretation Mat Confirmed

Comment:
g3-2-0016:18

Lung Age: b
35 years

-
ATC D mmrm Ao mibilibg Diees Ceibmri = B~k A A1 J

9.6 FVC Tab

Figure 9.8 FVC Tab

Patient: Test date:
CCNV.003 - John Doe, (M), 3/27/1967 2/8/2000 4:15:11 PM
FC | SWE I I I Trendl Measurementsl

12 12

Within normal limits

|FIOwNOIume Laop j |Selected Flowdolume ﬂ
Selection Description
Left Graph The left graph always represents the selected effort in the parameters
table as a flow volume loop or as tidal volume.
Right Graph The right graph displays curves all efforts selected for a particular stage.
Different curve views are selected from the drop down menu:
o Flow/Volume
o Volume/Time
3 Flow/Time
Axes In a flow volume graph, the flow is plotted against the volume.
In a volume/time graph, the volume is plotted against time.
Units e Volume is expressed in liters.

e Time is expressed in seconds.
e Flow is expressed in liters per second, or liters per minute based on
settings.
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9.7 SVC Tab

Figure 9.9 SVC Tab

Patigtt: Test date:

CCNV.003 - John Doe, (M), 3/27/1967 2/8/2000 4:15:11 PM
FvC  SVC | WA I Trendl Measurementsl

0 1 2 3 4 a3 G 7 i q o 11 12 13 14 15 16 17 1§ 19 20 0 22 I3
L . . . . . . . . . . . . ) . . . L . . . L .

SVC Test
Review results under the SVC tab.
Only volume/time (spirogram) graphs are displayed along with six SVC parameters.

Calipers mark the beginning and the end of the tidal area. Each effort line displayed on the
graph has a different color.

Note: Calipers can be manually adjusted. If so, affected parameters will automatically be
recalculated.

If no SVC test is performed, the SVC tab is disabled.
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9.8 MVV Tab

Figure 9.10 MVV Tab

Patigtt: Test date:
CCNV.003 - John Doe, (M), 3/27/1967 2/8/2000 4:15:11 PM
F/C I SVC MWW I Trend I Measurements I
1] 1 2 3 4 5 5 T g 9 10 11 12 13

1 B

2 B

3 B

qd

5 -

B .

? .

8 A

MVV Test

Review the results under the MVV tab.
Only volume/time (spirogram) graphs are displayed along with six MVV parameters.

Calipers (vertical lines) mark the beginning and the end of the ventilation volume (not the tidal
area).

Note: Calipers can be manually adjusted. If so, affected parameters will automatically be
recalculated.

Tip: You can select or deselect a curve in the parameters table.

If no MVV test is performed, the MVV tab is disabled.
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9.9 Trend Tab

Figure 9.11 Trend Tab

Patignt Test date:

CCNV.003 - John Doe, (M), 3/27/1967 8/23/2006 9:23:24 AM
FYC | ave | wyy {Trend

dI Measurements |

% Reference
™
5

t_DI cD‘ LD‘ LDI tDI
g% =3 K kS g%
a8 a5 gt 2m R
o o o 6g o og o R
52 5E 5E BE 2E
b s = b =

Efforts

& |FVC o & |FEV1 - & [FEW1% -

The Trends tab displays trends of:
¢ the FVC efforts of the test or
o the best pre and best post efforts of the several different tests of the same patient.

There is no limit to the number of tests that you can trend. You can simultaneously view three
parameters and see how the parameters evolve during the test.

The interpretation area shows the interpretation of the most recent test.

Figure 9.12 Parameters menus

* FVC - * FEY3 - ®* |FEM1 -

Selection Description

Parameters Three parameters are always trended. The choice of parameters trended
depends on the selected parameters in the settings (File> Settings>
Spirometry> Parameters tab> Six parameter column). When you exit the
trend view, SpiroPerfect remembers the last three parameters selected
and recalls them when you enter the trend view again.

Axes The horizontal axis displays the date & time of the efforts.

The vertical axis displays the parameter values:

e As a % of Predictive (effort x/pred value) x 100.

e Asapercentage of areference value. The value of the parameters is a
relative value. It depends on the currently selected effort. For
example, if a test has three efforts and effort 1 is selected, alll
parameter values for effort 1 are set to 100%. The values for other
efforts are expressed as lower or higher percentages in relation to
effort 1. (Effort x / Effort 1) x 100.

Example with Effort 1 currently selected
Effort1 | Effort 2 | Effort 3 | Effort 4

Real value of FEV1% 3.49 3.70 3.77 3.46

Relative value of FEV1% as displayed in trends 100% 106% 108% 99%
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To view trends:

1. Select three parameters from the drop down menus located beneath the Trends
graph. The curve for these parameters is displayed in the Trends graph.

2. Select or deselect efforts by checking the boxes beneath the efforts listed in the
parameters area. The efforts are added or removed from the Trends graph.

3. Select which effort is used as the reference point, by clicking on one of the efforts
located in the parameters area. The parameter value of this effort is set to 100% in
the Trend graph, and the parameter values of all other efforts are expressed as a
percentage proportional to the reference value. The percentage of deviation is given
in the parameters area.

Figure 9.13 Parameters Area
Effort ATS | Selected FvC FEW1 FEW1% FEW3 FEVE PEF
Units - L L kS L L Lis
473
0 Fre 101527 &M |No [w! 293 247 83 % 293 293 6.73
% Change 0.4% 125% 129% 0.4% 0.47% -229%
B Fre 101511 8 |No [w! 297 258 a7 % 297 297 10.50
% Change 01 % B8% B87% 0.1 % 01 % 194 %
0 Fre 101751 M Mo [w! 294 234 100.00 234 294 11.24
% Change 11% 42% 53X 11 11 278%
|!F're 10:17:34 A |No [v! 293 263 g7.84 293 293 362
% Change 05% 0% 75% 05% 05% -BEE %
Final - 294 294 100.00 294 294 11.24
Final%Pred - 62 % 7 126 % - - 122 %

4. You can select a line from the Trends graph by clicking on one of the points in the
line. The percentage deviation for each point is shown when you move the mouse
over a point in the line. By clicking on a different colored point you select the line of
that color and the percentage deviation for that line is displayed when moving over
the points of that line.

9.10 Measurements Tab
Figure 9.14 Measurement Tab
Patient: Test date:
CCNV.003 - John Doe, (M), 3/27/1967 8/23/2006 9:23:24 AM
RC | e | b | Trend Measurements |
Efforts Units ECCS/0uanier FVC Pre 1. FYCPre 2. FVCPre 2. FYC Pre 4. FYC Post 1 Final FinalZPred
1993
ATS - - Mo Mo Mo Mo Mo - -
FVC L 473 299 294 297 299 298 294 62%
FE41 L 3.90 2.63 2.94 2.58 2.47 2.82 2.94 k3
FEW1% % 0% TR 86 % B 4% a8 % 96 % 108 %
FEY3 L - 239 294 297 29 298 294 .
FEVE L - 2498 294 2.97 2499 298 294 =
FEF Lis 922 3.62 11.24 10,50 6.78 879 11.24 122 %
SWC L - : - - : - - -
WTsve L
MWisve L
IC L
ERY L
IRy L
[ L/min
YT e L
BFrvy b/min
e L
DFRC L
Time B
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The Measurements Tab contains a number of parameter values for each FVC, SVC and MVV
efforts. Each effort is represented by a separate column.

e The measurement table only displays the efforts belonging to the selected stage. It only
lists the parameters selected in the settings. See page 26 to select parameters for display
in the Measurement table.

¢ Information on test reproducibility is displayed in the reproducibility table that is placed
below the Measurements Table. In particular, the FVC and FEV1 absolute value variance
(difference) between the best effort and the second best effort is analyzed for both pre
and post tests.

e When avalue isin bold red text, that value is below the lower prediction limit.

9.11 Compare Tests
With SpiroPerfect, you can compare final results from different tests recorded for the same
patient.
Selecting various tests
1. Choose Action

2. Select Comparison

The following screen appears

Figure 9.15 Comparison dialog box

zl

Date&Time | Selection:
[ 9/6/2006 3:09:43 &M " Mone
O zra22000 4:15:11 PM Al

" Irwverted

Cancel |

Click on the check box in front of each test to select tests. The best pre and best post efforts
of the patient’s selected tests are compared.

Available views are:

e FVC
e Measurements
e Trend

The trend view displays a graphical overview of the patient’s performance over time.
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10 Interpreting Spirometry Tests

The Spirometer module can automatically interpret FVC efforts.

A computer generated interpretation cannot replace sound
WARNING medical reasoning by a trained professional. Therefore, a
physician should always review the interpretation.

10.1 Editing and Confirming an Interpretation

Figure 10.1 Interpretation editor

Interpretation,/Medication editor k|
& Confim ﬁ Cancel [ Clear D ateMirme EE Best Effort FYC Interpretation || 2 Comment
Sk tions Pre: FYC=5.60L FEV1= 4 70L FEV1/FWC= 8390%
i ronchadilator [2/8/2000 4:15:12 PM), Within normal limits

- Corticosteroids \ )
Interpretation

B- Interpretation
E----Within normal limits edit area

- Restrictive abnomalities
- Dbstructive abnormalities

M apbe a physiological variant Comment:
Mo interpretation poszible a2001618

\ Comment
\ pane

\

Statement Tree

In the Interpretation editor, text or interpretation statements are added to the interpretation
area. Once an interpretation is edited, confirm it. Otherwise, the edits are not saved.

Opening the interpretation editor
. Choose Tools and select Interpretation.
or
. Select Interpretation on the Toolbar, see Figure 4.1 Main Window

Automatically generated interpretation:

The generated interpretation is shown in the interpretation editor automatically if the
interpretation is unconfirmed. You can keep this interpretation and add text to it or replace it.
The automatic interpretation statements can be inserted by clicking the Best effort FVC
interpretation button.

Confirming an interpretation and closing the interpretation editor:
Select Confirm to save your comments and to return to the spirometry window.

Adding comments to the interpretation
Click in the comment pane and start typing the comment.

Adding text to the interpretation edit area
Click in the interpretation edit area and start typing the text.
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Adding an interpretation statement to the interpretation edit area using the statement
tree

1. Select a category to display the statements.

2. Inthe statement tree look up the statement to include in the interpretation.

3. Click on the statement to add it to the interpretation edit area.

Deleting an interpretation statement from the interpretation edit area
Select the statement text and press BACKSPACE or DEL to delete it.

Deleting a comment from the comment pane
Select the comment and press BACKSPACE or DEL to delete it.

Tips for editing and confirming an interpretation

e Automatically insert the current date and time by selecting the Date/time button.

e Clear the interpretation editor by selecting the Clear button.

e The statement tree can be changed. Please consult your system administrator or local
dealer for new or changed statements.

10.2 Automatic Interpretation

The spirometer module automatically calculates interpretive results as described in the
document noted in reference 2 on page 73.

The automatic interpretation is shown in the interpretation area if the interpretation is not

confirmed. If the interpretation is confirmed the confirmed interpretation is shown in the
interpretation area.

10.3 View Interpretation History

When making changes in an interpretation, the original interpretation is not changed, but a
new one is created. A copy of all interpretations is kept in the interpretation history.
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Figure 10.2 Interpretation History screen

Interpretation history El

y

= Interpretations D ate: EditedBy:
3/3/2005 10:57: 24 AM Unkerown

tild reztrictive abhormality

@Help ‘ ﬁ Done ‘

To view the interpretation history:
1. Choose Tools
2. Select Interpretation history. The Interpretation history window is displayed.
The left hand pane displays the interpretations sorted by date. The right hand pane
displays the content of each interpretation, including the date, time and editor.
3. Select a date to view an interpretation.

10.4 Reanalyze a Spirometry Test
Retrieve overwritten automatic interpretations by reanalyzing the spirometry test.

To reanalyze a spirometry test:
e Choose Actions
e Select Reanalyze test.

Reanalyzing the test will result in the following;

e A new interpretation is appended to the test containing the automatic interpretation
statements.

e The state of the interpretation is set to unconfirmed.

e All parameter values are re-calculated.

10.5 Recalculate prediction

With this option you can re-calculate the predicted values for the test with a different
Prediction norm.

To recalculate a prediction:
1. Go to the Action menu
2. Select Recalculate Prediction.
3. Select the preferred Prediction norm from the list.
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Note: for a more elaborate description of the Prediction norms see section 12.

4. Press the OK button.
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11 Printing Spirometry tests

11.1 Printing reports

To print a particular report for the test currently on your screen:
. Select File > Print

or
. Press Ctrl+P

The Print dialog box appears:

Figure 11.1 Print dialog box

prnt x|

—Frinter

M arne:

Drefault

Properties |

—FReport ~LCopie
|.-’-‘-.II Elus best effart FWC - Murmber of copies:
=
Best My [ —
Begt SWC
Best Three PVC v Callate
b eazurements MY

M easurements SVC
M easurements FYC b
Social Security ;I

—Fage range
v Al pages

" Curent page

k. Cancel

Select the desired print report type. The report type corresponding with the current view is
already selected. If you should so desire, you can select another report type.

Press the OK button to start printing.

To print multiple reports for the test currently on your screen:
. Select File > Print selected formats

or
) Press Ctrl+Alt+P

To control which reports will be printed, see page 28.
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11.2 Print Report Formats

The SpiroPerfect module prints the following report formats:
All plus best effort FVC
Best FVC
Best MVV
Best SVC
Best Three FVC
Measurements MVV
Measurements SVC
Measurements FVC
Social Security
Trend

Each format contains the patient’s personal information, test information, interpretation,

parameter table and all but the measurement report contain a graphs section.
Please refer to the Workstation manual for further information on printing a test.

11.3 Print Preview

To Preview a Test
e Select File > Print Preview. The print dialog box appears. See Figure 11.1.
e Select type of report to preview.

The name of the report type appears at the top of the dialog box.

The print preview window appears.

Figure 11.2 Print preview dialog box

% Print preview: Best F¥C

ShPint Setup || Page Width 100% | <

Name of the report type
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Norm Profiles

Each predictive norm supports a particular subset of parameters and covers a specific

population, as detailed in the profile charts below
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12.2

Norm-Related Clinical Studies

Each of the following studies provides expected values for various spirometric parameters by
measuring significant samples of a specific population.

Berglund Spirometric Studies in Normal Subjects. |. Forced Expirograms in Subjects 7-70 Years of

1963 Age, Berglund E., et. al., Acta Medica Scandinavica, vol. 173(2): 185-192, 1963.

Crapo Reference Spirometric Values using Techniques and Equipment that Meet ATS

1981 Recommendations, Crapo RO, et. al., American Review of Respiratory Disease 1981,
123:659-664.

Dockery Distribution of Forced Vital Capacity and Forced Expiratory Volume in One Second in

1983 Children 6-11 Years of Age, Dockery DW, et. al., American Review of Respiratory Disease
1983, 128:405-412.

ECCS/Quanjer Lung Volumes and Forced Ventilatory Flows: Official Statement of the European Respiratory

1993 Society, Quanjer Ph. H., et. al., European Respiratory Journal, 1993, vol. 6, Suppl. 16: 5-40.

Falaschetti Prediction equations for normal and low lung function from the Health Survey for England,

2004 Falaschetti E., et.al., European Respiratory Journal, 2004, 23: 456-463

Forche Il Neue spirometrische Bezugswerte fir Kinder, Jugendliche und Erwachsene; Forche G.,

1988 Harnoncourt K., Stadlober E.; Osterreichische Arztezeitung 43, 15-16, 1988.

Langhammer Forced Spirometry Reference Values for Norwegian Adults: The Bronchial Obstruction in

2001 Nord-Trondelag Study, Langammer A., Gulsvik A., et. al., European Respiratory Journal
2001, 18: 770-779.

Hedenstrom Reference Values for Lung Function Tests in Men: Regression Equations With Smoking

1986 Variables, Hedenstrém, H. et. al., Upsala Journal of Medicine Science 91:299-310, 1986.
Reference Values for Lung Function Tests in Females: Regression Equations With Smoking
Variables, Hedenstrém, H. et. al., Bull. Eur. Physiopathol. Respir. 1985, 21, 551-557.

Hibbert Lung function values from a longitudinal study of healthy children and adolescents. Hibbert

1989 ME, Lanigan A., Landau LI, Phelan PD, Pediatric pulmonology, 7:101-109, 1989.

Hsu Ventilatory Functions of Normal Children and Young Adults—Mexican-American, White and

1979 Black. I. Spirometry, Katharine HK Hsu, et. al., The Journal of Pediatrics; volume
95(1):14-23, July 1979.

Knudson The Maximal Expiratory Flow-Volume Curve. Normal Standards, Variability, and Effects of

1976 Age, Ronald J. Knudson, Ronald C. Slatin, Michael D. Lebowitz, and Benjamin Burrows.
American Review of Respiratory Disease, volume 113:587-600, 1976.

Knudson Changes in the Normal Maximal Expiratory Flow-Volume Curve With Growth and Aging,

1983 Ronald J. Knudson, et. al., American Review of Respiratory Disease 1983 127: 725-734.

Koillinen Terveiden suomalaislasten spirometrian ja uloshengityksen huippuvirtauksen viitearvot,

1998 Hannele Kaoillinen, et. al., Suomen Laakarilehti, 1998, 5 vsk 53, p. 395-402.

Kory The Veterans Administration-Army Cooperative Study of Pulmonary Function. I. Clinical

1961 Spirometry in Normal Men, Kory RC, et. al., American Journal of Medicine, February 1961,
243-258.

Morris Spirometric Standards for Healthy Nonsmoking Adults, James F. Morris, et. al., American

1971 Review of Respiratory Disease, 103: 57-67, 1971.

NHANES IIl'|| Spirometric Reference Values from a Sample of the General U.S. Population, John L.

1999 Hankinson, John R. Odencrantz, and Kathleen B. Fedan, Division of Respiratory Disease
Studies, National Institute for Occupational Safety and Health, Centers for Disease Control
and Prevention, Morgantown, West Virginia, 1999. The Third National Health And Nutrition
Examination Survey (NHANES IIl). Am J Respir Crit Care Med Jan 1999; 159:179-187.

Polgar Pulmonary Function Testing in Children: Techniques and Standards, Polgar G. and

1971 Promadhat V. Philadelphia, WB Saunders, 1971.
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Roca Spirometric Reference values from a Mediterranean population, J. Roca, J. Sanchis, A.

1986 Agusti-Vidal, F. Segarra, D. Navajas, R. Rodriguez-Roisin, P. Casan, S. Sans. Bull. Eur.
Physiopathol. Respir. 1986, 22, 217-224

Schoenberg Growth and Decay of Pulmonary Function in Healthy Blacks and Whites, Janet B.

1978 Schoenberg, Gerald J. Beck, and Arend Bouhuys, Respiration Physiology, 1978, 33,
367-393.

Solymar Nitrogen Single Breath Test, Flow-Volume Curves and Spirometry in Healthy Children, 7 -18

1980 Years of Age, L. Solymar, P. H. Aronsson, B. Bake, and J. Bjure. European Journal of Respir.
Dis. 1980, 61:275-286.

Viljanen Spirometric Studies in Non-smoking, Healthy Adults, AA Viljanen, et. al., The Scandinavian

1981 Journal of Clinical Lab Investigation, 41 supplement 159, 5-20, 1981.

Wang Wang X, Dockery DW, Wypij D, Fay ME, Ferris BG Jr., Pulmonary function between 6 and 18

1993 years of age. Pediatric Pulmonology 1993; 15: 75-88.

Zapletal Maximum Expiratory Flow-Volume Curves and Airway Conductance in Children and

1969 Adolescents, A Zapletal, EK Motoyama, KP Van De Woestijne, VR Hunt and A. Bouhuys,
Journal of Applied Physiology, vol. 26, no. 3:308-316, March 1969.

12.3 Norm Extrapolation

Extrapolation is the practice of applying a norm’s formula to a patient whose profile doesn't fit
that norm’s profile. For example, if you were testing an 88-year-old man, and the primary
(selected) norm was based on males 85 or younger, the predicted values are extrapolated
values.

e When it takes place, extrapolation is indicated in the test record.

e Pediatric norms do not provide any age, weight, or height extrapolation.

¢ Adult norms allow extrapolation of age up, but not down.

e Adult norms allow extrapolation of height, weight, up and down.

12.4 Composite Norm Values

When the Composite norm, see tables in section 12.1, is selected, predictive parameter
values are filled in from one of the alternative (composite) norm sources listed here.

NHANESIII FVC, FEV1, FEV1%, FEV6, FEV1/FEV6, FEV6/FVC, PEF,
FEF25-75

Crapo 1981 FEVO0.5, FEV3, FEV3/FVC

Morris 1971 FEF0.2-1.2

ECCS/Quanjer 1993 FEF25, FEF50, FEF75

Note: If an adult norm is selected but pediatric patient data is used — no prediction value
will be calculated and displayed.

The following combinations of horms are supported:

Predicition Norm Age range | Composite norm
Egggar 1;%3 ECCS/Solymar
é?:pclestal 18:%3 ECCS/zapletal
aggggﬁ@m 25%3 Hedenstrom/Solymar*

*The Composite of Hedenstrom/Solymar cannot be used for age 19
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For a listing of the parameters included in each norm, see section 12.1 Norm Profiles.

125 Lung Age

Lung age is a calculated value based on a patient’'s demographics and spirometric
performance. This provides a relative indication of the health of the patient's lungs. This value
is used primarily to encourage smoking cessation.

The SpiroPerfect spirometer, calculates lung age values according to the document cited in
Reference 4 (Morris, 1985). For single-effort tests, lung age is based on the current effort.
Otherwise, it is based on the patient’s “best” pre effort as defined in the settings.

Lung age calculations are provided only for patients 20 and older. For patients older than 84
years the lung age is extrapolated. This limitation is derived from the subject population on
which Morris based his research. The lung age is one floating point number in years: the
average of the 4 formulas in the Morris article (FVC, FEV1, FEF25-75%, and FEF0.2-1.2).
Specifically, lung age is calculated as follows:

Gender Lung Age Formula

Men [5.920 (height) — 40.000 (FVC) — 169.640 +
2.870 (height) — 31.250 (FEV1) — 39.375 +
2.319 (height) — 21.277 (FEF200-1200) + 42.766 +
1.044 (height) — 22.222 (FEF25%-75%) + 55.844 1/ 4

Women  [4.792 (height) — 41.667 (FVC) — 118.833 +
3.560 (height) — 40.000 (FEV1) — 77.280 +
4.028 (height) — 27.778 (FEF200-1200) — 70.333 +
2.000 (height) — 33.333 (FEF25%-75%)+18.367 ] / 4

height in inches

12.6 Ethnic group correction

Studies have demonstrated that expected values for certain spirometric parameters can vary
significantly from one ethnic group to another. Some norm studies include separate
regression equations for different races but most others do not.

In the latter case Welch Allyn CardioPerfect applies ethnic group correction to all
non-Caucasian adult patients in the prediction formulas. The interpretation area will state if
the norm values are extrapolated. The ATS (for blacks) or NIOSH (for Asians)
recommendations will be used for extrapolation.

Race Choices FVC&FEV1 Recommendation Source
Caucasian No adjustment -

Black 88% ATS

Asian 94% NIOSH

Hispanic No adjustment None found

Native American No adjustment None found

Note Race adjustment applies for adults only and applies to all supported parameters
within the norm study.

If a race adjustment percentage is used, the same adjustment is applied to the LLN
value.
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12.7 Understanding Interpretation Results

The following diagram illustrates the process of collecting and interpreting spirometry data.
For details, see the document noted in reference 8.

Figure 12.1 Data Interpretation Process
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= REPEAT
MANEUVER(S)
BEST OF 3?7
RATIO s
ABNORMAL i w i
NORMAL
SPIROMETRY
May be a
PR Mild 0% < FVC < LLN
mﬁ::nulﬂl N Restriction @
no
Mild Moderate . 60% < FVC < 70%
Obstruction Restriction L of Predicted?
no
Moderate :me" 50% < FVC < 60%
i 2g ﬂ of Predicted?
Obstruction Restriction
no
- Severe 3% < FVC < 50%
Obstruction Restriction of Predicted?
no
Severe Very ?“!’-“ E FVC < 34%
Obstruction | Restriction of Predicted?
Very Severe
Obstruction
FVC Below 80% of predicted?

And low vital capacity, cannot rule out superimposed restriction.
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1. Disability Evaluation Under Social Security (the “blue book”), Social Security
Administration SSA publication number 64-039, Office of Disability Programs ICN
468600, January 2003.

See in particular the calibration and reporting sections of this document.

2. Lung Function Testing: Selection of Reference Values and Interpretive Results,
American Thoracic Society, March 1991.

This document describes the methods of selecting the reference values and the
algorithm for interpretative results.

3. National Occupational Respiratory Mortality System, National Institute for
Occupational Safety and Health (NIOSH).

4. Short Report Spirometric “Lung Age” Estimation for Motivating Smoking Cessation,
James F. Morris, M.D., and William Temple, Preventive Medicine 14, 655-662, 1985.

5. ATS/ERS Task Force: Standardisation of Lung Function Testing, European
Respiratory Journal, Volume 26 Number 2, 319-338, 2005.

This document describes the methods of acquiring the output parameters and the
required accuracy. For details on ATS/ERS acceptability criteria, see these sections:
. “Start of Test Criteria,” page 324

o “Manoeuvre repeatability,” page 325

6. Standardized Lung Function Testing, European Respiratory Journal, volume 26,
supplement number 16, April 2005.

7. U.S. Pulmonary Function Standards for Cotton Dust Standard, 29 CFR 1910.1043,
Appendix D.

8. Lung Function Testing: Selection of reference values and interpretive strategies.

American Thoracic Society, American Review of Respiratory Disease,
144:1202-1218 (1991).
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13 Maintaining the Spirometer — Welch Allyn

13.1 Maintaining the Sensor

The Spirometer sensor needs little maintenance to stay in good working condition. Change
the flow transducer for each patient. Check periodically for damages. Check that all
connections are properly aligned and tight. Visually check the pressure tubing for leaks and
kinks. Check for irreversible bending or compression of the pressure tubing between flow
transducers and device.

Ensure spirometer is calibrated and that the proper lot code and calibration code is used. The
lot code and calibration code can be found on the flow transducer package. For more detailed
information please refer to chapter 7 the Calibration chapter of this manual.

Avoid placing spirometer and any of its components in direct sunlight or in a dusty
environment.

Caution To make reliable recordings, calibrate the sensor on a daily basis.
Keep track of the calibrations in the calibration log.

13.2 Cleaning the Spirometer

You cannot clean the spirometer or any of its components. If you choose to clean the
calibration syringe, wipe its external surfaces as needed with a cloth dampened with water
only.

Warni ng Sati_sfactory maintenance procedures must be implementeq,_or
equipment failure and health hazards may result. Only qualified

service personnel should repair the equipment. See “Limited
Warranty” and “Service Policy”, page 4.

To prevent cross-contamination, do not try to clean the flow
transducers and nose clips. Discard these items after a single
patient use. Wear rubber gloves when replacing flow transducers,
and wash hands after touching them.
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Do not clean the pressure tubing or sensor. Trapped moisture

could affect accuracy.

o Replace the pressure tubing when it becomes dirty. Recalibrate
after replacement.

e Replace the sensor when it becomes faulty. See section 13.3
Ordering Information for Replacement Parts on page 75.

e Do not immerse any part of the spirometer into a cleaning liquid
or sterilize it with hot water, steam, or air.

e Do not use aromatic hydrocarbons, rubbing alcohol, or solvents

for cleaning the Spirometer.

0O
o
=
o
>

13.3 Ordering Information for Replacement Parts
The following parts must be replaced as noted:

o flow transducers & nose clips — Replace for each new patient.
e pressure tubing — Replace when dirty.
e sensor — Replace when faulty.

To order parts, call the Welch Allyn Technical Support Center.

& Warni ng Discard all spirometry components according to local regulations.

Use of components other than those recommended by Welch Allyn may compromise product
performance. The Welch Allyn warranty can only be honored if you use Welch Allyn approved
components and replacement parts.
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Figure 13.1 Ordering Information for Replacement Parts

Item Part Order
Numbers Quantities

Disposable Flow £ 703418 25 pk

Transducer N 703419 100 pk

(CPWS,CP200)
Package includes Lot

o .
code and Calibration /
code _/ 4

Pressure Tubing 703415 1
(CPWS, CP200, 2m)

Sensor 703554 1
Spirometer USB Kit

Sensor 703554 1
Spirometer Serial Kit 703552 1

Nose Clip 58550-0000 1

Calibration Syringe . 703480 1
3L,CPWS,CP200,SPIRO
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14 Troubleshooting

Condition

Solution

The Device (sensor) is not responding

Disconnect and reconnect the sensor.

Check if the port settings in the settings menu
correspond with the used COM-port.

Measured values are incorrect

Verify LOT number and perform a verification
test.

Check the flow transducer for potential
obstruction.

Do a volume calibration to check the
gain-factor and to recalibrate the device if
necessary.

Values are too high (intermittent)

Retest with fingers positioned properly
around the flow transducer. Do not block the
end of the flow transducer with your fingers or
hand.

Flow data is out of range (measured
flow has exceeded the allowable limits)

Recalibrate with a 3-liter syringe.

The program does not predict values or
the values appear incorrect

Check in the settings menu to see if the
correct author is selected.

Verify that the date of birth, gender, race and
the height of the patient are correctly entered
in the patient card; these are needed for the

calculation of the predicted values. For some
prediction norms the patient’s weight is also

obligatory.

Unable to calibrate

Verify sensor calibration information.

Check the connection between flow
transducer and sensor.

Replace the flow transducer.
Check that the connection between the
syringe and the flow transducer is tight and

without leaks.

Use even strokes in calibration.
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Condition

Solution

Error message:
No valid stroke recorded.

Wait with pushing the plunger in until the blue
calibration bar starts moving.

Pull the plunger completely out before
pressing the OK button on the start
calibration window.

Report does not print parameters or
graphs

Check print and parameters settings.

Indistinguishable Pre and Post curves
on printed reports

A color printer and a color printout are
recommended for printing Spirometry
reports. Printing these reports with a
monochrome printer or in black and white
can lead to confusion as it is not easy to
identify which curve is a Pre and which is a
Post effort.

Patient test values differ from values
expected by physician

Verify sensor calibration information.

Verify the barometric pressure.

Recalibrate.

Replace transducer.

Verify the patient data. The norm selection is
dependent upon accurate input of patient
data in the SpiroPerfect database.

Eliminate any leaks in the pressure tubing.

Replace the sensor if damaged.

Make sure the patient remains still during
recording.

The flow sensor has been dropped

Recalibrate.

Loss of network connection during
spirometry test
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15 Specifications

Specification

Description

SpiroPerfect

Computer based full diagnostic spirometer

Tests

FVC, SVC, MVV, Pre-Post BD

Sensor Type

Pneumotach

Power Equipment

None, obtained from USB port

Accuracy

Meets or exceeds ATS/ERS 2005 standard

Reproducibility

Meets or exceeds ATS/ERS 2005 standard

Volume Range

0-14 L

Flow Range

+- 14 L/sec

Predictive Norms

For Predictive Norms included, see 12.2

Additional predictive norms can be added upon customer request

Interpretation 1991 ATS Interpretation Standards.
Automatic interpretation can be disabled.
Manual Interpretation available.
Lung Age calculation

Reports FVC - Volume / Time

FVC - Flow / Volume
FVC - Both — Volume / Time and Flow / Volume
SVC - Volume / Time

Incentive graphic

Fireman

Parameters FVC, FIVC, FIV1, FIV1%, FEVO0.5, FEV1, FEV2, FEV3, FEV5, FEV6, FEVO0.5,
FEV0.5%, FEV1%, FEV1/FVC, FEV2%, FEV3%, FEV5%, FEV6%, PEF, FEF25,

FEF50, FEF75, FEF0.2-1.2, FEF25-75, FEF75-85, PIF, FIF50, FEF50/FIF50,

FEV1/FEV6, FET, MEF25, MEF50, MEF75
SVC, ERV, IRV, VT, IC, BF, MV, Tin, Tex, Tin/Tex
MVV, MV, VT, BF, DFRC

Quality Checks

ATS Acceptability and ATS Reproducibility checks
Audio and visual incentive for assistance in coaching patients

Connectivity

Compatible with CardioPerfect Workstation

Export compatible with most electronic medical records programs
Available in multi user network

Telemedicine option for e-mail transfer

Storage and
Environment

e Temperatures between —20 °C (-4 °F) and 50 °C (122 °F).
e Relative humidity between 15 and 95% (non-condensing).
e Atmospheric Pressure of 500 hPa (mbar) to 1,060 hPa (mbar).
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Specification Description

Operation Environment e

Temperatures between 10 °C (50 °F) and 40 °C (104 °F),
Relative humidity between 15% and 90% (non-condensing),
Atmospheric Pressure of 700 hPa (mbar) to 1,060 hPa (mbar),
Warm up period of 5 minutes.
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16 Statutory and Regulatory Requirements

MDD - Medical Device Directive (MDD) 93/42/EEC

IEC/EN 60601-1-1, Medical Electrical Equipment, General Requirements for safety, Safety
requirements for medical electrical systems.

IEC/EN 60601-1 Medical Electrical Equipment — General Requirements for Safety

IEC 60601-1-2 Medical Electrical Equipment - Safety Requirements - EMC

IEC/EN 60601-1-4 Collateral Standard for Programmable Medical Systems

CAN/CSA C22.2 No. 601.1-M90/UL 60601-1, Medical Electrical Equipment — General
Requirements for Safety

The authorized representative in the European Community
Welch Allyn LTD.

Navan Business Park

Dublin Road

Navan, County Meath, Republic of Ireland

Tel.: 353-46-90-67700

Fax: 353-46-90-67755

4341 State Street Road
Welcl\A]lyn“ Skaneateles Falls, NY 13153 USA
Tel: 800 535-6663 (North America Only) or 315 685-4560
Fax: 315 685-3361
www.welchallyn.com
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17 Guidance and Manufacturer’'s Declarations

é Caution

The Welch Allyn SpiroPerfect spirometer needs special precautions
regarding EMC and needs to be installed and put into service
according to the following EMC information provided.

Portable and mobile RF communications equipment can affect the
Welch Allyn SpiroPerfect spirometer.

Electromagnetic Emissions

The Welch Allyn SpiroPerfect is intended for use in the electromagnetic environment specified below. The customer
or the user of the Spirometer should assure that it is used in such an environment.

Emissions test Compliance Electromagnetic environment — guidance
RF emissions Group 1 The Welch Allyn SpiroPerfect uses RF energy only for its
internal function. Therefore, its RF emissions are very low and
CISPR11 are not likely to cause any interference in nearby electronic
equipment.
RF emissions Class A The Welch Allyn SpiroPerfect is suitable for use in all

CISPR 11

establishments other than domestic, and may be used in
domestic establishments and those directly connected to the

Harmonic emissions

IEC 61000-3-2

public low-voltage power supply network that supplies buildings
used for domestic purposes, provided the following warning is
heeded:

Warning: This equipment/system is intended for use by
healthcare professionals only. This equipment/system may

Not applicable

Voltage fluctuations/
flicker emissions

IEC 61000-3-3

cause radio interference or may disrupt the operation of nearby
equipment. It may be necessary to take mitigation measures,
such as re-orienting or relocating the Welch Allyn SpiroPerfect
or shielding the location.

Not applicable
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Electromagnetic Immunity

The Welch Allyn SpiroPerfect is intended for use in the electromagnetic environment specified below. The customer
or the user of the Spirometer should assure that it is used in such an environment.

Immunity test

IEC 60601
test level

Compliance level

Electromagnetic environment
— guidance

Electrostatic discharge
(ESD)

IEC 61000-4-2

+6 kV contact

+8 kV air

+6 kV contact

+8 kV air

Floors should be wood, concrete
or ceramic tile. If floors are
covered with synthetic material,
the relative humidity should be at
least 30 %.

Electrical fast
transient/burst

+2 kV for power supply
lines

Not Applicable

Mains power quality should be
that of a typical commercial or
hospital environment.

IEC 61000-4-4 +1 kV for input/output lines

Surge +1 kV differential mode Not Applicable Mains power quality should be
that of a typical commercial or

IEC 61000-4-5

+2 kV common mode

hospital environment.

Voltage dips, short
interruptions and
voltage variations on
power supply input lines

IEC 61000-4-11

<5 9% Ut
(>95 % dip in Ur)
for 0,5 cycle

40 % U~
(60 % dip in Ur)
for 5 cycles

70 % Ur
(30 % dip in Ur)
for 25 cycles

Not Applicable

Mains power quality should be
that of a typical commercial or
hospital environment. If the user
of the Welch Allyn SpiroPerfect
requires continued operation
during power mains
interruptions, it is recommended
that the Welch Allyn SpiroPerfect
be powered from an
uninterruptible power supply or a
battery.

<5 % Ur
(>95 % dip in Ur)
for 5 sec
Power frequency (50/60 | 3 A/m 3 A/m Power frequency magnetic fields
Hz) magnetic field should be at levels characteristic
of a typical location in a typical
IEC 61000-4-8

commercial or hospital
environment.

NOTE Uris the AC mains voltage prior to application of the test level.
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Electromagnetic Immunity

The Welch Allyn SpiroPerfect is intended for use in the electromagnetic environment specified below. The customer
or the user of the Welch Allyn SpiroPerfect should assure that it is used in such an environment.

Immunity test IEC 60601 Compliance level Electromagnetic environment —
test level guidance

Portable and mobile RF communications
equipment should be used no closer to any
part of the Welch Allyn SpiroPerfect,
including cables, than the recommended
separation distance calculated from the
equation applicable to the frequency of the
transmitter.

Recommended separation distance

Conducted RF 3Vrms 3Vrms d=12-JP
IEC 61000-4-6 150 kHz to 80 MHz
Radiated RF 3Vim 3Vim

d=1.2-/P 80to800MHz
IEC 61000-4-3 80 MHz to 2,5 GHz

d=23.-JP 800 MHzto 2,5 GHz

where P is the maximum output power rating
of the transmitter in watts (W) and d is the
recommended separation distance in
meters (m).

Field strengths from fixed RF transmitters,
as determined by an electromagnetic site
survey?, should be less than the compliance
level in each frequency range.b

Interference may occur in the vicinity of
equipment marked with the following

@)

symbol:

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and
reflection from structures, objects and people.

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land
mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with
accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey
should be considered. If the measured field strength in the location in which the Welch Allyn SpiroPerfect is used
exceeds the applicable RF compliance level above, the Welch Allyn SpiroPerfect should be observed to verify
normal operation. If abnormal performance is observed, additional measures may be necessary, such as
reorienting or relocating the Welch Allyn SpiroPerfect.

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
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Recommended separation distances between portable and mobile RF
communications equipment and the Welch Allyn SpiroPerfect

The Welch Allyn SpiroPerfect is intended for use in an electromagnetic environment in which radiated RF
disturbances are controlled. The customer or the user of the Welch Allyn SpiroPerfect can help prevent
electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications
equipment (transmitters) and the Welch Allyn SpiroPerfect as recommended below, according to the maximum
output power of the communications equipment.

Separation distance according to frequency of transmitter

Rated maximum m
output power of
transmitter 150 KHz to 80 MHz 80 MHz to 800 MHz 800 MHz to 2,5 GHz
w d=1.2-VP d=1.2-VP d=23-P
0,01 0.12 0.12 0.23
0,1 0.37 0.37 0.74
1 1.2 1.2 2.3
10 3.7 3.7 7.4
100 12 12 23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in
meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the
maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and
reflection from structures, objects and people.
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18 Spiro Perfect VCT-400

The Spiro Perfect VCT-400 product was sold only in Europe and is discontinued. It will be
supported until December 31, 2009.

The Product consists of two elements: the spirometry sensor, and the software that runs on
the computer to which the sensor is connected. Before you can start recording spirometry
tests, you need to:

e Connect the sensor to the computer.
e Configure the software.

OEM Spirometer: VIASYS Healthcare GmbH, Hoechberg, Germany, Vicatest 400
c € 0123

18.1 Connect the flow sensor to the computer

Connecting the flow sensor to the computer:

1. Turn off your computer.

2. Connect the serial connector of the flow sensor to a free serial port on the computer.

3. Disconnect the mouse from your computer and connect it to the female PS2
connector of the Spiro Perfect VCT-400 flow sensor.

4. Connect the male PS2 connector of the Spiro Perfect flow sensor to the mouse port
of your computer.

5. Start the computer.

18.1.1  Configure Welch Allyn CardioPerfect Workstation

After connecting the flow sensor, configure Welch Allyn CardioPerfect Workstation.

Configuring Welch Allyn CardioPerfect Workstation for use with the flow sensor:
1. Start Welch Allyn CardioPerfect Workstation.
2. Choose File> Settings> Spirometry.
3. Select the Recording tab.
4. Select the Spiro Perfect VCT 400.
5. Setthe COM-port number to the number of the serial port connecting the flow sensor
to the Welch Allyn CardioPerfect Workstation.
6. Select OK to save the settings.

18.1.2  Preparing the flow sensor

Preparing the flow sensor for recording:
1. Switch on the flow sensor
Note: The power switch is located on the bottom of the flow sensor.
2. Wait for the green LED indicator glow.

3. Insert a disposable mouthpiece into the flow sensor.
Note: The flow sensor is ready for recording.
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18.2 Maintaining the flow sensor

The Spirometer flow sensor needs little maintenance to stay in good working condition. Only
clean and sterilize it.

Caution To make reliable recordings, calibrate the sensor on a daily basis.
Keep track of the calibrations in the calibration log.

Cleaning and Disinfection Procedure Spirometer:

Mouthpiece
The cardboard mouthpiece is for single patient use only. Discard it after the test.

Housing
Clean the outside of the housing with a non-aggressive cleaning agent daily.

Holder and sensor
Clean and disinfect the holder and sensor after each test.

Cleaning:
1. Use an ultrasound bath with a household cleaning agent.
2. Rinse thoroughly with distilled water afterwards
3. Letitdry.

Note: Clean holder and sensor immediately after a test. It will be more difficult to
clean when saliva dries on the sensor.

Disinfection
Leave the sensor and holder emerged in alcohol (max. 70%) for 5 to 10 minutes (if it is left
emerged for a longer period, the glue inside the sensor may dissolve).

Caution Never use Isopropyl alcohol, this dissolves the glue in the sensor.
The use of “Spiritus Ketonatus Dilutus" (70%) is recommended. This

alcohol solution consists of 70% ethanol and 0.5%
methylethylketon.

Other recommended disinfection substances are: (best used in an
ultrasound bath):

e Secusept forte in a concentration of 1.5%

e Lysoformin 3000

e Descogen

After disinfection, rinse the parts thoroughly with distilled water.
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18.3 Troubleshooting

Condition

Solution

Flow sensor is not responding

e Check if the flow sensor is switched on
(switch located on the bottom of the
device)

e Check if the device is connected both to
a COM port (for communication) and to a
PS2 port (for power)

e Check if the COM-port settings in the
CPWS settings menu correspond with
the used COM port

Measured values are incorrect

e Check the turbine. Take it out of the
device and move it freely in the room so
that air streams through it. The fan
should rotate when you move it and stop
quite abrupt when the movement is
stopped (provided there is no draft in the
room. If the vane does not rotate freely,
the turbine probably needs to be
replaced.

e Do a volume calibration to check the
gain-factor and to recalibrate the device if
necessary.

Registration of low volume rates

e Rotor has been overtightend after
disassembly or there is some mechanical
friction. Disassemble device and
re-assemble correctly.

Indistinguishable Pre and Post curves
on printed reports

e A color printer and a color printout are
recommended for printing Spirometry
reports. Printing these reports with a
monochrome printer or in black and white
can lead to confusion as it is not easy to
identify which curve is a Pre and which is
a Post effort.
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19 Function keys

The Welch Allyn CardioPerfect module is, just like all Windows applications, designed for
working with the mouse. However, there might be situations in which working with the
keyboard can be quicker. Therefore a number of functions within the Welch Allyn
CardioPerfect module can also be selected directly using the keyboard. Here is a list of all
available keyboard shortcuts in this module, for a more general function key description
please refer to the Workstation manual:

Spirometry functions

Key Function

[SHIFT]+[CTRL]+[S] |Starts a new spirometry recording.
F6 Reanalyze

F7 Comparison

F9 Opens the Ambient settings dialog
F10 Starts the Calibration process
[CTRL]+[L] Opens the Calibration log
[CTRLI]+[E] Add new effort

[CTRL]+[I] Opens the Interpretation window
[CTRL]+[H] Opens the Interpretation History
[CTRL]+[D] Delete current effort

[CTRL]+[T] Edit comment

Recording new test

Key Function

F2 Start/stop test

[Esc] Exit the recording, cannot exit when recording is active.
[ALT]+F4 Close recording/test
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20 Glossary

adult. Generally, 18 or older. Age limits vary with each norm.
ASS. American Security Society.

ATS. American Thoracic Society. An organization that provides standards for spirometry
common practice and equipment.

ATS acceptability criteria. Applicable to FVC testing only. (1) Criteria ensuring that an
individual effort started and ended satisfactorily (no leaks or coughs). (2) Criteria ensuring
that the patient has made at least two efforts of the same kind (two FVC-pre or two FVC-post),
and that these efforts are reproducible. For details, see document noted in reference 5.

ATS interpretive results. The software calculates interpretive results as described in the
document noted in reference 2.

baseline. See pre-test.

best effort. A measurement calculated from a set of efforts. The formula for calculating best
effort is user-selectable: (1) the single best effort or (2) a composite of best parameter values.

BF. Breathing frequency. See also MV and tidal breathing.
bronchospasm evaluation. See post-test.

BTPS. Body conditions, normal body temperature (37° C), ambient pressure, saturated with
water vapor. The BTPS correction factor converts ambient conditions—temperature,
humidity, and pressure— to BTPS.

CardioPerfect workstation. A PC using Welch Allyn CardioPerfect software. Stores ECG
and spirometry test data. Can communicate with other electronic patient-information
systems, such as billing and medical records.

composite norm value. A value that is filled in from another norm—a “composite horm
source”—when the primary (selected) norm does not support a given parameter. Applicable
only when “composite norm values” is enabled.

COPD. Chronic obstructive pulmonary disease. Characterized by airflow obstruction that is
primarily caused by smoking. Examples include emphysema, chronic bronchitis, and
asthmatic bronchitis.

curve. A graphical display of spirometry data. During SVC testing, only one curve type is
available: volume/ time. During FVC testing, three curve types are available: volume/time,
flow/volume, and flow/time.

effort. A single spirometry maneuver, for example, one blow. A test typically comprises
multiple efforts. See also best effort and test.

ERS. European Respiratory Society.

ERV. Expiratory reserve volume (in liters). The maximum volume that can be expired from the
level of the functional residual capacity (FRC). See also tidal breathing.

extrapolation. The practice of applying a norm’s formula to a patient who doesn’t fit that
norm’s demographics. For example, if you were testing an 88-year-old man, and the primary
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(selected) norm were based on males 85 or younger, the predicted values would be
extrapolated values.

FEF50/FIF50. The ratio of these two parameters. See FEF50 and FIF50.

FEF25. Forced expiratory flow (in L/s) at 25% of FVC.

FEF50. Forced expiratory flow (in L/s) at 50% of FVC.

FEF75. Forced expiratory flow (in L/s) at 75% of FVC.

FEF85. Forced expiratory flow (in L/s) at 85% of FVC.

FEFO0.2-1.2. Forced expiratory flow average (in L/s) between 0.2 and 1.2 liters of FVC.
FEF25-75. Forced expiratory flow average (in L/s) during the middle half of FVC.

FEF75-85 (“late” FEF). Forced expiratory flow average (in L/s) between 75% and 85% of
FVC.

FET. Forced expiratory time (in seconds). The elapsed time from the beginning of expiration
until a specified percentage of FVC.

FEVO0.5. Forced expiratory volume (in liters) at 0.5 seconds.

FEV1. Forced expiratory volume (in liters) at 1 second. An important parameter because it
reflects the severity of COPD.

FEV1/FEV6. The ratio of these two parameters. See FEV1 and FEV6.

FEV1/FVC. See FEV1%.

FEV2. Forced expiratory volume (in liters) at 2 seconds.

FEV3. Forced expiratory volume (in liters) at 3 seconds.

FEVS5. Forced expiratory volume (in liters) at 5 seconds.

FEV6. Forced expiratory volume (in liters) at 6 seconds.

FEVO0.5%. FEV0.5 as % of FVC.

FEV1%. FEV1 as % of FVC. Same as FEV1/FVC. A parameter for a single FVC effort.

FEV1% formula. A user-selectable formula that determines the calculation method for a
test’s (not an effort’s) overall FEV1% value, which affects the automatic interpretation.

FEV2%. FEV2 as % of FVC.
FEV3%. FEV3 as % of FVC.
FEV5%. FEVS5 as % of FVC.
FEV6%. FEV6 as % of FVC.

FEVt. Timed forced expiratory volume (in liters). Volume of air exhaled in the specified time
during an FVC effort.
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FIF50. Forced inspiratory flow (in L/s) at 50% of FIVC.
FIV1. Forced inspiratory volume (in liters) at one second.
FIV1%. FIV1 as % of FIVC.

FIVC. Forced inspiratory vital capacity (in liters). The maximum volume of air that can be
inspired during forced inspiration starting from full expiration.

FIVt. Timed forced inspiratory volume (in liters). Volume of air inhaled in the specified time (t).
flow. The speed at which air is inhaled or exhaled (in L/s).
flow = f(v). See flow/volume.

flow/volume. Same as flow over volume or flow = f(V). A type of data curve available during
FVC testing. The y axis represents flow (L/s); the x axis represents volume (liters).

flow loop. A flow/volume curve that includes inspiratory data (negative values on the y axis).

FRC. Functional residual capacity (in liters). Volume of air remaining in the lungs and airway
at the average end-expiratory level.

FVC. Forced vital capacity. (1) A type of test in which patients inhale fully and exhale
forcefully for as long as they can. The goal: to measure the volume and flow of air. May or
may not include forced inhaling. When forced inhaling is included, it may be done either
before or after exhaling. See flow loop. (2) An important parameter (in liters): the maximum
volume of air that can be delivered during forced expiration starting from full inspiration.

IC. Inspiratory capacity (in liters). The maximum volume of air that can be inhaled after a
normal— unforced—exhalation. See also tidal breathing.

incentive screen. An animated screen that gives patients—usually children—a goal to
achieve while exhaling. This screen is listed as a type of “curve” (data display) available
during FVC testing.

IRV. Inspiratory reserve volume (in liters). The maximum volume that can be inspired from the
average end-inspiratory level. See also tidal breathing.

LLN. Lower limits of normal. The lowest expected value for a spirometric parameter. The
method of determining this value varies from norm to norm.

lung age. A calculated value based on a patient’s demographics and spirometric
performance that gives a relative indication of the health of the subject's lungs. This value is
used primarily to encourage smoking cessation. Lung age is not available for patients
younger than 20 years.

maneuver. See effort.

MV. Minute volume (in liters). The volume of air expired per minute measured over at least
one minute. MV = BF « VT. See also tidal breathing.

norm. A research-based spirometry data set with a specific profile for race, gender, age, and
height. The software compares each patient’s results with data in the primary (selected)
norm, reporting the results as percentages of the predicted (normal) values.

normal. Consistent with norm data.
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parameter. A commonly defined attribute of a spirometric waveform (FVC, FEV1, and so on).
pediatric. Generally, under 18 years old. Age limits vary with each norm. Also young
children’s lung sizes vary greatly. Norm values and interpretive results are not available for
patients under 3 years of age. Pediatric use in the US for ages 6 and above.

PEF. Peak expiratory flow (in L/s). The largest expiratory flow achieved with a forced effort.
PIF. Peak inspiratory flow (in L/s). The largest inspiratory flow achieved with a forced effort.
post-test. A test that provides data to compare with pre-test data. Sometimes called post-Rx
or post-BD (bronchodilator). A post-test must follow a pre-test within 24 hours. See also
reversibility.

predictive curve. A curve that follows a set of predictive points.

predictive points. Key values from the selected norm and from composite norms (if
enabled). Applicable for FVC tests only. For flow/volume curves, predictive values are PEF,
FEF25, FEF50, FEF75, and FVC (all are represented as points). For volume/time curves,
predictive values are FEV1 (represented as point) and FVC (represented as horizontal line). If
predictive points are enabled, all available values appear on the screen and the printout.
pre-test. A test that provides a baseline for comparison with a post-test taken by the same
patient. Sometimes called pre-Rx or pre-BD (bronchodilator). Pre-tests and post-tests are
commonly used to evaluate the effectiveness of medication. See also reversibility.
reversibility. The percentage difference between pre-test and post-test data. This
measurement indicates the effect of medication on lung function. Reversibility applies to each
parameter separately. The reversibility formula, which determines the way in which
reversibility is calculated, is user-selectable.

SVC. Slow (relaxed) vital capacity. (1) A type of test in which patients breathe normally
several times, then inhale maximally and exhale maximally, or vice versa. (2) An important
parameter (in liters): the maximum volume of air exhaled from the point of maximum
inhalation, or maximum volume of air inhaled from a point of maximum exhalation.

test. A set of efforts—at least 1 and no more than 12—in various possible combinations of
FVC efforts, SVC efforts, or both. Tests may include pre- and post-efforts (FVC or SVC to
measure the effectiveness of medication.

Tex. Tidal breathing expiration time (in seconds). See also tidal breathing.

tidal breathing. Spontaneous or normal breathing. See also Tin and Tex.

tidal volume. See VT.

Tin. Tidal breathing inspiration time (in seconds). See also tidal breathing.

Tin/Tex. The ratio of these two parameters. See also Tin and Tex.

TV. See VT.

variance. The difference between the best and second best effort’s parameter for FEV1 and
FVC. Pretest and post-test variance are reported separately. See also best effort.

VC. Vital capacity. See also FVC and SVC.

volume = f(t). See volume/time.
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volume/time. Same as volume over time or volume = f(t). A type of data curve available
during both FVC and SVC testing. The y axis represents liters; the x axis represents seconds.

VT. Tidal volume (in liters). Also called TV, although VT is the preferred abbreviation. The
volume of air that enters the lungs during inspiration and leaves the lungs during expiration in
a normal breathing cycle. See also MV and tidal breathing.

workstation. See CardioPerfect workstation.
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